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Chapter 17:  
Dedicated 8XX Bulk Add Ordering 

Overview 

 

Introduction This chapter discusses how to download and use the Control Center® 
Dedicated 8XX Batch Formatter application to create 8XX Bulk Add 
files. CenturyLink requires that all files transferred by the customer be 
in the 8XX Bulk Add format. Customers who do not have the capability 
to build 8XX Bulk Add files from their own application should use the 
Control Center Dedicated 8XX Batch Formatter software. 
 

The Dedicated 8XX Batch Formatter is used to create new 8XX Bulk 
Add files for adding Dedicated 8XX numbers to a customer’s account.  
In addition, this chapter explains how to perform these functions for 
Dedicated 8XX Bulk Add Ordering tool. 
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Downloading the Dedicated 8XX Batch Formatter 

 
Procedure Follow the steps in the table below to download the Dedicated 8XX 

Batch Formatter software to your computer. 
 

Step Action 

1  Navigate to Control Center > Orders > Initiate Orders > 
Batch: 

 

Result: The Batch screen appears. 

 
2  Select Ordering Type as Dedicated: 

 

 
 
Result: Batch screen updates to display Formatting Tool 
and Template for Dedicated 8XX Batch 
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3  Click the Dedicated 8XX Batch Formatter link. 

Result: The File Download window appears. 

 

4  Click Run to begin loading the application on your computer. 

Result: The installer screen appears. 

 

5  Select Next. 

Result: The Choose Install Folder window appears. 

 

Continued on next page 
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Downloading the Dedicated 8XX Batch Formatter, Continued 

  
Procedure (continued) 

 
Step Action 

6  Enter the destination for the application and select Next. 

Result: The Choose Shortcut Folder window appears. 

 

7  Select where the product icon is to be placed and select 
Next. 

Result: The Pre-Installation Summary window appears. 
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Downloading the Dedicated 8XX Batch Formatter, Continued 

  
Procedure (continued) 
 

Step Action 

8  Verify the Pre-Installation Summary and click Install. 

Result: The Installing Dedicated 8XX Batch Formatter 
window appears. 

 

9  Once installation is complete, Click Done to quit the 
Installer. 

Result: The Dedicated 8XX Batch Formatter is now 
installed. 
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Menus 

 
Description The Control Center Dedicated 8XX Batch Formatter has two main 

menu options: File and Tools. These menu options enable quick and 
easy completion of the available tasks in the Dedicated 8XX Batch 
Formatter. 

 
File Menu The table below briefly describes the options on the Dedicated 8XX 

Batch Formatter File menu. 
 

Options Function 

New This option enables you to create a new order file. 

Open/Import This option enables you to load and edit existing 
files. 

Save This option enables you to save files. 

Save As This option enables you to save a file as a different 
name, different extension, etc. 

Save As ZIP This option enables you to save the file as a zip file. 

Close This option enables you to close the active file. 

Close All This option enables you to close all files. 

Quit This option enables you to quit and exit the 
application. 

 
Tools Menu The table below briefly describes the options on the Dedicated 8XX Batch 

Formatter Tools menu. 
 

Options Function 

Add Row This option enables you to insert a new row. 

Delete Row This option enables you to delete a selected row. 

Note: The Delete key on your keyboard deletes 
the contents of a selected field within the 
Dedicated 8XX Batch Formatter. 

Copy Row This option enables you to copy a selected row. 

Paste Row This option enables you to paste a copied row. 

Validate This option enables you to check for format issues 
when creating a new file or editing an error file. 

Find/Replace This option enables you to find and replace an 
existing column value with a new column value. 
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Required Fields 

 
Introduction Creating a batch file requires that a specific set of account information 

be present. The tables that follow list the required fields for 8XX 
numbers. 

 

FIELD NAME TYPE LENGTH FORMAT 

DEDICATED/ 
SWITCHED/ 

BOTH 
REQUIRED 

Y/N/C 

HEADER RECORD       

BATCH_ID CHAR 3 or 4 ALPHA/NUMERIC BOTH Y 

BATCH_TYPE CHAR 7 ALPHA/NUMERIC BOTH Y 

FILE_DATE NUM 8 YYYYMMDD BOTH Y 

SUBMIT_DATE NUM 8 YYYYMMDD BOTH Y 

ORDER_ID CHAR 15 ALPHA/NUMERIC BOTH N 

PRIMARY_CONTACT_NAME CHAR 30 ALPHA/NUMERIC DED Y 

PRIMARY_CONTACT_EMAIL CHAR 60 ALPHA/NUMERIC DED Y 

PRIMARY_CONTACT_PHONE NUM 10 NUMERIC DED Y 

PRIMARY_EXT NUM 4 NUMERIC DED N 

PRIMARY_COUNTRY CHAR 3 ALPHA DED N 

PRIMARY_CONTACT_DIAL_CD NUM 4 NUMERIC DED N 

SECONDARY_CONTACT_PHONE NUM 10 NUMERIC DED N 

SECONDARY_EXT NUM 4 NUMERIC DED N 

FAX NUM 10 NUMERIC DED N 

COMPANY_NAME CHAR 35 ALPHA/NUMERIC DED Y 

ACCT_MGR_NAME CHAR 30 ALPHA/NUMERIC DED Y 

CUSTOMER_PON CHAR 16 ALPHA/NUMERIC DED N 

RELATED_PON CHAR 16 ALPHA/NUMERIC DED N 

REQUESTED_DUE_DATE NUM 8 YYYYMMDD DED Y 

DATA RECORD       

CUSTOMER_ACCOUNT_ID NUM 12 NUMERIC BOTH Y 

PRODUCT_ACCOUNT_ID NUM 12 NUMERIC BOTH Y 

ACTION_CD CHAR 1 A BOTH Y 

ORDER_TYPE CHAR 1 N, C DED Y 

CMP_GROUP_CD CHAR 2 IW BOTH Y 

CUSTOMER_TYPE CHAR 1 B,R BOTH Y 

TERMINATION_METHOD CHAR 3 OCC, DED BOTH Y 

8XX NUM 10 NUMERIC BOTH Y 

RING_TO_ANI NUM 10 NUMERIC Future Use N 

LOA_DATE NUM 8 YYYYMMDD BOTH Y 

RESP_ORG_ID CHAR 5 ALPHA/NUMERIC BOTH Y 

AREA_OF_SERVICE CHAR 2 ALPHA BOTH Y 

CLASS_OF_SERVICE NUM 3 NUMERIC BOTH Y 
 

Continued on next page 
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Required Fields, Continued 

 

FIELD NAME TYPE LENGTH FORMAT 

DEDICATED/ 
SWITCHED/ 

BOTH 
REQUIRED 

Y/N/C 

QWEST_IS_RESP_ORG CHAR 1 Y, N BOTH Y 

COMMENTS_REMARKS CHAR 2000 ALPHA/NUMERIC BOTH N 

8XX_ENHANCED_IND CHAR 1 Y, N BOTH Y 

PRIMARY_TRUNK_1_NM CHAR 12 ALPHA/NUMERIC DED Y 

PRIMARY_SWITCH_1_ID NUM 3 NUMERIC DED Y 

PRIMARY_DNIS 1 NUM 10 NUMERIC DED N 

PRIMARY_TRUNK_1_TYPE CHAR 3 ALPHA DED N 

DTO_TRUNK_2_NM CHAR 12 ALPHA/NUMERIC DED N 

DTO_SWITCH_2_ID NUM 3 NUMERIC DED N 

DTO_DNIS_2 NUM 10 NUMERIC DED N 

DTO_TRUNK_2_TYPE CHAR   ALPHA DED N 

DTO_TRUNK_3_NM CHAR 12 ALPHA/NUMERIC DED N 

DTO_SWITCH_3_ID NUM 3 NUMERIC DED N 

DTO_DNIS_3 NUM 10 NUMERIC DED N 

DTO_TRUNK_3_TYPE CHAR 3 ALPHA DED N 

DTO_ANI NUM 10 NUMERIC DED N 

REALTIME_ANI_IND CHAR 1 Y, N DED Y 

DNIS_DIGITS NUM 2 1 – 10 DED N 

END_USER_NM CHAR 35 ALPHA/NUMERIC BOTH Y 

PAYPHONE_BLOCK_IND CHAR 1 Y, N BOTH Y 

FEATURE_PERCENT_1 NUM 3 1-100 Both N 

TRUNK_GRP_NM_1 CHAR 12 ALPHA/NUMERIC Both C 

SWITCH_ID_1 NUM 3 NUMERIC Both C 

DNIS_1 NUM 10 NUMERIC Both C 

TRUNK_GRP_TYPE_1 CHAR 3 ALPHA Both C 

TRUNK_GRP_NM_2 CHAR 12 ALPHA/NUMERIC Both C 

SWITCH_ID_2 NUM 3 NUMERIC Both C 

DNIS_2 NUM 10 NUMERIC Both C 

TRUNK_GRP_TYPE_2 CHAR 3 ALPHA Both C 

TRUNK_GRP_NM_3 CHAR 12 ALPHA/NUMERIC Both C 

SWITCH_ID_3 NUM 3 NUMERIC Both C 

DNIS_3 NUM 10 NUMERIC Both C 

TRUNK_GRP_TYPE_3 CHAR 3 ALPHA Both C 

DTO_ANI  NUM 10 NUMERIC Both C 

 

Continued on next page 
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Required Fields, Continued 

 

FIELD NAME TYPE LENGTH FORMAT 

DEDICATED/ 
SWITCHED/ 

BOTH 
REQUIRED 

Y/N/C 

FEATURE_PERCENT_2 NUM 3 1-100 Both N 

TRUNK_GRP_NM_1 CHAR 12 ALPHA/NUMERIC Both C 

SWITCH_ID_1 NUM 3 NUMERIC Both C 

DNIS_1 NUM 10 NUMERIC Both C 

TRUNK_GRP_TYPE_1 CHAR 3 ALPHA Both C 

TRUNK_GRP_NM_2 CHAR 12 ALPHA/NUMERIC Both C 

SWITCH_ID_2 NUM 3 NUMERIC Both C 

DNIS_2 NUM 10 NUMERIC Both C 

TRUNK_GRP_TYPE_2 CHAR 3 ALPHA Both C 

TRUNK_GRP_NM_3 CHAR 12 ALPHA/NUMERIC Both C 

SWITCH_ID_3 NUM 3 NUMERIC Both C 

DNIS_3 NUM 10 NUMERIC Both C 

TRUNK_GRP_TYPE_3 CHAR 3 ALPHA Both C 

DTO_ANI NUM 10 NUMERIC Both C 

FEATURE_PERCENT_3 NUM 3 1-100 Both N 

TRUNK_GRP_NM_1 CHAR 12 ALPHA/NUMERIC Both C 

SWITCH_ID_1 NUM 3 NUMERIC Both C 

DNIS_1 NUM 10 NUMERIC Both C 

TRUNK_GRP_TYPE_1 CHAR 3 ALPHA Both C 

TRUNK_GRP_NM_2 CHAR 12 ALPHA/NUMERIC Both C 

SWITCH_ID_2 NUM 3 NUMERIC Both C 

DNIS_2 NUM 10 NUMERIC Both C 

TRUNK_GRP_TYPE_2 CHAR 3 ALPHA Both C 

TRUNK_GRP_NM_3 CHAR 12 ALPHA/NUMERIC Both C 

SWITCH_ID_3 NUM 3 NUMERIC Both C 

DNIS_3 NUM 10 NUMERIC Both C 

TRUNK_GRP_TYPE_3 CHAR 3 ALPHA Both C 

DTO_ANI NUM 10 NUMERIC Both C 

FEATURE_PERCENT_4 NUM 3 1-100 Both N 

TRUNK_GRP_NM_1 CHAR 12 ALPHA/NUMERIC Both C 

SWITCH_ID_1 NUM 3 NUMERIC Both C 

DNIS_1 NUM 10 NUMERIC Both C 

TRUNK_GRP_TYPE_1 CHAR 3 ALPHA Both C 
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Required Fields, Continued 

 

FIELD NAME TYPE LENGTH FORMAT 

DEDICATED/ 
SWITCHED/ 

BOTH 
REQUIRED 

Y/N/C 

TRUNK_GRP_NM_2 CHAR 12 ALPHA/NUMERIC Both C 

SWITCH_ID_2 NUM 3 NUMERIC Both C 

DNIS_2 NUM 10 NUMERIC Both C 

TRUNK_GRP_TYPE_2 CHAR 3 ALPHA Both C 

TRUNK_GRP_NM_3 CHAR 12 ALPHA/NUMERIC Both C 

SWITCH_ID_3 NUM 3 NUMERIC Both C 

DNIS_3 NUM 10 NUMERIC Both C 

TRUNK_GRP_TYPE_3 CHAR 3 ALPHA Both C 

DTO_ANI NUM 10 NUMERIC Both C 

FEATURE_PERCENT_5 NUM 3 1-100 Both N 

TRUNK_GRP_NM_1 CHAR 12 ALPHA/NUMERIC Both C 

SWITCH_ID_1 NUM 3 NUMERIC Both C 

DNIS_1 NUM 10 NUMERIC Both C 

TRUNK_GRP_TYPE_1 CHAR 3 ALPHA Both C 

TRUNK_GRP_NM_2 CHAR 12 ALPHA/NUMERIC Both C 

SWITCH_ID_2 NUM 3 NUMERIC Both C 

DNIS_2 NUM 10 NUMERIC Both C 

TRUNK_GRP_TYPE_2 CHAR 3 ALPHA Both C 

TRUNK_GRP_NM_3 CHAR 12 ALPHA/NUMERIC Both C 

SWITCH_ID_3 NUM 3 NUMERIC Both C 

DNIS_3 NUM 10 NUMERIC Both C 

TRUNK_GRP_TYPE_3 CHAR 3 ALPHA Both C 

DTO_ANI NUM 10 NUMERIC Both C 

PRODUCT_TRANSFER_IND CHAR 1 Y,N Both Y 

TRAILER RECORD       

RECORD_COUNT NUM 12 NUMERIC BOTH Y 

TRAILER_IDENTIFIER CHAR 5 <EOF> BOTH Y 
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Creating a New Batch (Add) File 

 
Overview The batch file can be created via three different methods; follow one of 

the methods below to create a new batch file. 

1. Enter data directly into the Batch Formatter 
2. Enter data into the 8XX Bulk Add File Format template; or 
3. Copy data from a spreadsheet and paste it into the Batch 

Formatter 
 
Procedure 1. Enter Data Directly into the Batch Formatter 

Step Action 

1  Launch the Dedicated 8XX Batch Formatter application and 
create a new file [File > New]. 

Result: A new file window appears. 

 

Continued on next page 
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Creating a New Batch (Add) File, Continued 

   
Procedure (continued) 

 
Step Action 

2  Key the header information in the Header Record of the 
Batch Formatter per the Required Fields section of this 
document. 

 

3  Key the data information in the Data Record of the Batch 
Formatter per the Required Fields section of this document. 

 

Continued on next page 
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Creating a New Batch (Add) File, Continued 

  

Procedure (continued) 
 

Step Action 

4  Validate the file information [Tools > Validate]. 

Result: The file is validated or formatting errors. 

 

5  Correct any errors that may appear in the Validation Results 
section. 
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Creating a New Batch (Add) File, Continued 

 
Procedure Enter Data into the 8XX Bulk Add File Format template 

 
The 8XX Bulk Add File Format template is located in Control Center 
[Resources > Tools > 8XX Batch Ordering Template]. The template 
is a spreadsheet used to arrange the data to be loaded into the Batch 
Formatter application,  via the CenturyLink Protected Internet Delivery 
[QPID] utility for scripted uploads to the Control Center folders, or in 
Control Center via Ordering > Batch Ordering > Orders to Process 
8xx. It is divided into three sections – Header Record, Data Record 
and Trailer Record. Each field must be populated with the required 
information for the order to be provisioned successfully. 
 
Header & Trailer Records 

 The file must be tab-delimited 
 A tab must come before and after fields in the header and 

trailer 
 The Header Record must be the first line of the file and be 

followed by a carriage return 
 The Trailer Record must be the last line of the file 

Data Records 
 A tab must follow each data field between the first and last 

field of each record. If a field is null, a tab should be inserted 
before and after the null value, e.g. if there are three fields 
and the second field is a null value, the format would be: Field 
1{tab}{tab}Field3 where Field1 and Field3 represent the field 
contents 

 84 tabs should exist for each Data Record (85 data fields) 
 When viewing the file, field spacing may be different for each 

record due to the tab-delimited format (e.g. the 
Comment_Remarks field may only be 20 characters for one 
record and 75 for another) 

 Do not enter a tab after the last field; use a carriage return 
instead 

Continued on next page 
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Creating a New Batch (Add) File, Continued 

  
Procedure (continued) 

 

Step Action 

6  Open a copy of the Bulk Load template, available at Control 
Center > Resources > Orders > Initiate Orders > Batch: 

 

7  Populate each field with the provisioning data. Insert a 
space in the last field (DTO ANI for the 5th Percent 
Allocation Rule) by pressing the spacebar followed by the 
Enter key (this ensures the proper tab lengths are saved). If 
the file includes multiple 8XXs or rows, this cell can be 
copied down to the last 8XX on the order. 

 

Continued on next page 
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Creating a New Batch (Add) File, Continued 

 
Procedure (continued) 

 

8  Delete all rows EXCEPT the Header, Data Records and 
Trailer. 

 

9  Click File > Save As. 

 
Continued on next page 
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Creating a New Batch (Add) File, Continued 

  
Procedure (continued) 

 
Step Action 

10  Enter a new file name in the File Name field. 
 
The file name must adhere to the following parameters: 

 Use a unique file name 
 Use .txt as the file extension (tab delimited format) 
 The file name must contain at least 13 characters 
 Example: 01012004CTLTA.txt 
 Where month, day, and year are in MMDDYYYY format 

(ex.: 01012004) 
 Where the three-digit customer code (ex.: CTL). (The 

customer code is validated during the submission 
process and must be populated correctly) 

 Where the letter T identifies the file as tab-delimited 
 Where sequential letters of the alphabet identify more 

than one file sent in one calendar day, e.g. A for the 
first file and B, C, D, etc. for subsequent files sent the 
same day 

Note: File names with the same root name but different 
extensions are not recognized as different files. 
Submitting files with the same name will result in the 
file being rejected by CenturyLink.  For example: 
11082003CTLTA.txt, 11082003CTLTA.tx1, and 
1108CTLTA.tx3 would all be viewed as the same 
file (11082003CTLTA) and be rejected by the 
system. 

Continued on next page 
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Creating a New Batch (Add) File, Continued 

 
Procedure (continued) 

 
Step Action 

11  In the Save As Type field, select Text (Tab delimited) as 
the format type. 

12  Click Save. 

 

13  Select OK if prompted with a ‘multiple sheets’ decision box. 

 

Continued on next page 
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Creating a New Batch (Add) File, Continued 

 
Procedure (continued) 

 

14  Select Yes when prompted with Tab-delimited decision box. 

 

15  Open the file using a text application such as Notepad or 
Text pad (Text pad is recommended because hidden 
characters such as tabs, spaces, etc. can be viewed). If 
using Text pad, select the Visible icon to view hidden 
characters in the file. 

16  Remove extra spaces or tabs after the 
requested_due_date data field in the header row of the 
file. 

17  Remove extra spaces or tabs after the trailer_identifier 
data field found in the trailer row of the file. 

18  Click Save. 
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Creating a New Batch (Add) File, Continued 

 
Procedure Copy data from a spreadsheet and paste it into the Batch Formatter 

 

Step Action 

19  Open a new file in the Dedicated 8XX Batch Formatter [File > 
New]. 

 

20  Copy the header information from the original spreadsheet 
and paste in the Header Record section of the Batch 
Formatter file. 
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Creating a New Batch (Add) File, Continued 

 

Procedure (continued) 

 

21  Copy data information from the original spreadsheet and 
paste in the Data Record section of the Batch Formatter file. 

 

22  Validate the information and correct any validation errors that 
may have been detected by the Validate function. 

 

23  Save the file as previously noted (for example, 
01012004CTLTA.txt). 
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Editing an Existing Batch (Add) File 

 
Procedure To edit an existing batch file, complete the following steps: 
 

Step Action 

1  From the File menu, select Open/Import. 

 

2  Select the file to be edited and click Open. 

 
 

Continued on next page 
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Editing an Existing Batch (Add) File, Continued 

 
Procedure (continued) 

 
Step Action 

3  The file loads into the Batch Formatter application. 

 

4  Edit the file as necessary and click Save As from the File 
menu. 

 
 

Continued on next page 
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Editing an Existing Batch (Add) File, Continued 

 
Procedure (continued) 

 
Step Action 

5  Navigate to the folder in which to save the file. In the File 
name field, name the batch file. 

 

6  Click Save. 

Result: The file is saved to the specified location. 
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Using the Add Row Function 

 
Procedure To add a row in the batch file, complete the following steps: 
 

Step Action 

1  From the Tools menu, select Add Row [Tools > Add Row] 

Result: A new row is added after the last row in the file. 

 

2  Key in the data record information in the new row for an 8xx 
number. 
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Using the Delete Row Function 

 
Procedure To delete a row in the batch file, complete the following steps: 
 

Step Action 

1  From the Tools menu, select Delete Row [Tools > Delete 
Row]. 

Result: The selected row is deleted. 
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Using the Copy Row Function 

 
Procedure Follow the steps in the table below to copy a row in the batch file. 
 

Step Action 

1  Select the row to be copied. 

 

2  From the Tools menu, select Copy Row [Tools > Copy 
Row]. 
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Using the Paste Row Function 

  
Procedure Follow the steps in the table below to paste a row in the batch file. 
 

Step Action 

1  After selecting the row to be copied, select Tools > Paste 
Row 

Result: The row is pasted as the last row. 
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Using the Validate Function 

 
Procedure Follow the steps in the table below to validate the batch file. 
 

Step Action 

1  Select Tools > Validate to verify the file is error-free. 

Result: Errors, if any, are noted in the Validation Results 
section of the window. 

 

2  Correct the errors and validate the file again to ensure all 
errors have been reconciled. 

3  Save the file [File > Save As]. 
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Using the Find/Replace Function 

 
Procedure Follow the steps in the table below to find and replace items in the 

batch file. 
 

Step Action 

1  From the Tools menu, select Find/Replace [Find > 
Replace]. 

 

2  Select the column to search and the find/replace criteria, 
then click the OK button. 
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Copying Information from Excel 

  

Procedure Information can be copied from a field in an Excel spreadsheet to a 
field in the Batch Formatter. Follow the steps below to copy 
information from Excel to a batch file. 

 

Step Action 

1  Enter information into the Batch Formatter either by creating 
a new file or loading an existing file. 

 

2  Open the Excel spreadsheet from which you want to copy 
information and click once in the field to be copied. 

 

3  From the Excel Edit menu, click Copy. 
 

Continued on next page 
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Copying Information from Excel, Continued 

 
Procedure (continued) 
 

Step Action 

4  In the Batch Formatter, click the field in which you want to 
paste the information. 

5  Select CTRL + V on the computer keyboard. 

Result: The new field information is pasted into the batch 
file. 
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Dedicated 8XX Batch File Format 

 
Introduction The batch file format may be used for sending dedicated service 

orders to CenturyLink through the File Transmission function. The 
batch file format, detailed in this chapter, will accommodate all 
transaction and service types, with multiple types within a single file. 

 
Guidelines for 
Preparing 
your File 

To successfully upload a Dedicated 8XX batch file, it must be named 
based on the following criteria: 

 Use a unique file name 

 Use .txt as the file extension (tab delimited format) 

 The file name must contain at least 13 characters 

 Month, day and year are in MMDDYYYY format (ex.: 01012004) 

 The three-digit customer code (ex.: CTL). (The customer code is 
validated during the submission process and must be populated 
correctly) 

 The letter T identifies the file as tab-delimited 

 Sequential letters of the alphabet identify more than one file sent 
in one calendar day, e.g. A for the first file and B, C, D, etc. for 
subsequent files sent the same day 

 Example: 11082003CTLTA.txt 
 
Note: File names with the same root name but different extensions are not 
recognized as different files. Submitting files with the same name will result in the file 
being rejected by CenturyLink. For example: 11082003CTLTA.txt, 
11082003CTLTA.tx1, and 1108CTLTA.tx3 would all be viewed as the same file 
(11082003CTLTA) and be rejected by the system. 
 

 
Header and 
Trailer 
Records 

The following are guidelines for Header and Trailer records: 

 The file must be tab-delimited 

 A tab must come before and after fields in the header and trailer 

 The Header Record must be the first line of the file and be 
followed by a carriage return 

 The Trailer Record must be the last line of the file 

Note: See the Dedicated 8XX Batch File Format Data Dictionary. 
 

Continued on next page 
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Dedicated 8XX Batch File Format, Continued 

 
Data Records The following are guidelines for Data records: 

 A tab must follow each data field between the first and last field 
of each record. If a field is null, a tab should be inserted before 
and after the null value, e.g. if there are three fields and the 
second field is a null value, the format would be: Field 
1{tab}{tab}Field3 where Field1 and Field3 represent the field 
contents 

 84 tabs should exist for each Data Record (85 data fields) 

 When viewing the file, field spacing may be different for each 
record due to the tab-delimited format (e.g. the 
Comment_Remarks field may only be 20 characters for one 
record and 75 for another) 

 Do not enter a tab after the last field; use a carriage return 
instead 
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Dedicated 8XX Batch File Format Data Dictionary 

 
Header 
Record 

This is the first line of the file; contains required information for every 
submitted file. All fields must exist as indicated with no punctuation 
unless noted. 
 
BATCH_ID 
Example: BATCH_ID=ABC (or ABCD) 
Identifies your company’s Control Center Customer ID. Use your 
Customer ID in place of ‘ABC’ (or ‘ABCD’ in the example above). Your 
Customer ID may contain either 3 or 4 characters. 
 
BATCH_TYPE 
Example: BATCH_TYPE=BT_WH8A 
This is an unchangeable field. The required value is BT_WH8A. 
 
FILE_DATE 
Example: FILE_DATE=20031108 
Identifies the date the file was created. The required format is 
YYYYMMDD. 
 
SUBMIT_DATE 
Example: SUBMIT_DATE=20031108 
Identifies the date the file was submitted. The required format is 
YYYYMMDD. 
 
ORDER_ID 
Example: ORDER_ID=AABC1108 
Your company's internal Order ID – user-defined. 
 
PRIMARY_CONTACT_NAME 
Example: PRIMARY_CONTACT_NAME=Jane Doe 
Identifies the Contact Name for the file submitted. This information 
may be used if CenturyLink needs to contact you in reference to the 
order. 
 
PRIMARY_CONTACT_EMAIL 
Example: 
PRIMARY_CONTACT_EMAIL=jane.doe@centurylink.com 
Identifies the Contact Name’s email address for the file submitted. This 
information may be used if CenturyLink needs to contact you in 
reference to the order. 

 
Continued on next page 
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Dedicated 8XX Batch File Format Data Dictionary, Continued 

 
Header 
Record 
Continued 

PRIMARY_CONTACT_PHONE 
Example: PRIMARY_CONTACT_PHONE=9012345678 
Identifies the Contact Name’s Primary Phone number for the file 
submitted. This information may be used if CenturyLink needs to 
contact you in reference to the order. 
 
PRIMARY_EXT 
Example: PRIMARY_EXT=5678 
Identifies the Contact Name’s Primary Ext number for the file 
submitted. This information may be used if CenturyLink needs to 
contact you in reference to the order. 
 
PRIMARY_COUNTRY 
Example: PRIMARY_COUNTRY=USA 
Identifies the Country on the Primary Contact for the file submitted. 
This information may be used if CenturyLink needs to contact you in 
reference to the order. 
 
PRIMARY_CONTACT_DIAL_CD 
Example: PRIMARY_CONTACT_DIAL_CD=1234 
Identifies the Dial Code for the country of the Primary Contact for the 
file submitted. This information may be used if CenturyLink needs to 
contact you in reference to the order. 
 
SECONDARY_CONTACT_PHONE 
Example: SECONDARY_CONTACT_PHONE=8901234567 
Identifies the Contact Name’s Secondary Phone number for the file 
submitted. This information may be used if CenturyLink needs to 
contact you in reference to the order. 
 
SECONDARY_EXT 
Example: SECONDARY_EXT=5678 
Identifies the Contact Name’s Secondary Ext number for the file 
submitted. This information may be used if CenturyLink needs to 
contact you in reference to the order. 

 
Continued on next page 
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Dedicated 8XX Batch File Format Data Dictionary, Continued 

 
Header 
Record 
Continued 

FAX 
Example: FAX=7890123456 
Identifies the Contact Name’s Fax number for the file submitted. This 
information may be used in the event CenturyLink needs to contact in 
reference to your order. 
 
COMPANY_NAME 
Example: COMPANY_NAME=CenturyLink Communications 
Identifies your company name. 
 
ACCT_MGR_NAME 
Example: ACCT_MGR_NAME=John Doe 
Identifies the support Service Delivery Representative for your 
company. This information will be bridged with your order to provide 
support and tracking to ensure order flow through. 
 
CUSTOMER_PON 
Example: CUSTOMER_PON=A20031108BC 
Identifies your Purchase Order Number for the file, if needed. 
 
RELATED_PON 
Example: RELATED_PON=D20031108ABC 
Identifies any related purchase order numbers, if needed. 
 
REQUESTED_DUE_DATE 
Example: REQUESTED_DUE_DATE=20031108 
Identifies the date you are requesting completion of the order. Please 
enter a future date in the format of YYYYMMDD. 

 
Continued on next page 
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Dedicated 8XX Batch File Format Data Dictionary, Continued 

 
Data Record Each data record is a Toll Free order. There is a limit of 1,000 data 

records/ orders for a given file. 
 
CUSTOMER_ACCOUNT_ID 
Example: CUSTOMER_ACCOUNT_ID=30000000 
Your Customer Account ID. 
 
PRODUCT_ACCOUNT_ID 
Example: PRODUCT_ACCT_ID=300000 
The second identifier which allows CenturyLink to associate the 
reseller customer with your Customer Account. 
 
ACTION_CD 
Example: ACTION_CD=A 
The action for a given record/order. 
The available Action Codes are: 
A - Add 
 
ORDER_TYPE 
Example: ORDER_TYPE=N 
The identifier associated with the type of Toll Free Service being 
requested. 
The available Toll Free services are: 
N – New (reserved) 
C – Complementary  
 
CMP_GROUP_CD 
Example: CMP_GROUP_CD=IW 
Component Group Code is the identifier associated with the 
customer's service. 
The available Component Group Codes are: 
IW - 8XX or Toll Free 
 
CUSTOMER_TYPE 
Example: CUSTOMER_TYPE=R 
Identifies the customer as Residential or Business. 
The available values for this field are: 
R - Residential 
B – Business 

 
Continued on next page 
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Dedicated 8XX Batch File Format Data Dictionary, Continued 

 
Data Record 
Continued 

TERMINATION_METHOD 
Example: TERMINIATION_METHOD=OCC 
The identifier associated with the line type as Dedicated or Switched. 
The available values for this field are: 
OCC 
DED 
 
8XX 
Example: 8XX=8000000000 
The 10-digit number to which all incurred charges are billed. 
 
RING_TO_ANI 
Example: RING_TO_ANI=6140000000 
The Ring-To Number for an 8XX. This field is for future release. 
 
LOA_DATE 
Example: LOA_DATE=20031108 
The Letter of Agency (a.k.a. Letter of Authorization) Date identifying 
the date the customer authorizes you to provide long distance service. 
The format is YYYYMMDD. 
 
RESP_ORG_ID 
Example: RESP_ORG_ID=LGT01 
Identifies the organization currently responsible for providing service 
for an 8XX. If you are ordering a new 8XX, this field should be 
populated with LGT01. If you own your RespOrg for Complementary 
Services, this field must contain the current RespOrg ID as defined in 
the National SMS. 
 
AREA_OF_SERVICE 
Example: AREA_OF_SERVICE=UG 
Works in accordance with the COS to specify your requested area of 
origination for a given 8XX. 
 
CLASS_OF_SERVICE 
Example: CLASS_OF_SERVICE=108 
Works in accordance with the AOS to indicate your requested area of 
origination for a given 8XX. 

 
Continued on next page 
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Dedicated 8XX Batch File Format Data Dictionary, Continued 

 
Data Record 
Continued 

CENTURYLINK_IS_RESP_ORG 
Example: CENTURYLINK_IS_RESP_ORG=Y 
Specifies whether or not the customer would like CenturyLink as the 
responsible organization to provide 8XX service. 
The available options are: 
Y - Yes 
N - No 
 
COMMENTS_REMARKS 
Example: COMMENT_REMARKS=Customer would like to add 
Percentage Allocation at a later time. 
Optional field used to associate information with a record/order. 
 
8XX_ENHANCED_IND 
Example: 8XX_ENHANCED_ID=Y 
Specifies whether or not the customer would like enhanced features 
for the Toll Free record/order. The following features are considered 
enhanced in the Bulk Add Tool = Percentage Allocation. All other 
feature sets (DNIS, DTO, Payphone Blocking and Real Time ANI) are 
not considered enhanced. 
The available options are: 
Y - Yes 
N - No 
 
PRIMARY_TRUNK_1_NM 
Example: PRIMARY_TRUNK_1_NM=CTL00000CXZZ 
Identifies the primary/global trunk group the Toll Free number will 
terminate to. 
 
PRIMARY_SWITCH_1_ID 
Example: PRIMARY_SWITCH_1_ID=000 
Identifies primary/global switch id the Toll Free number will terminate 
to. 
 
PRIMARY_DNIS_1 
Example: PRIMARY_DNIS_1=8000000000 
Identifies primary/global DNIS the Toll Free number will terminate to. 
To ensure correct file processing, DNIS digits cannot begin with a 0 
(zero). Using 0 as the lead character in DNIS digits results in the 0 
being removed from the DNIS as the file is processed. 

 
Continued on next page 
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Dedicated 8XX Batch File Format Data Dictionary, Continued 

 
Data Record 
Continued 

DTO_TRUNK_2_NM 
Example: DTO_TRUNK_2_NM=CTL11111CXZZ 
Identifies the trunk group termination for the first overflow route. 
 
DTO_SWITCH_2_ID 
Example: DTO_SWITCH_2_ID=001 
Identifies the switch termination for the first overflow route. 
 
DTO_DNIS_2 
Example: DTO_DNIS_2=8000000001 
Identifies the DNIS for the first overflow route. To ensure correct file 
processing, DNIS digits cannot begin with a 0 (zero). Using 0 as the 
lead character in DNIS digits results in the 0 being removed from the 
DNIS as the file is processed. 
 
DTO_TRUNK_3_NM 
Example: DTO_TRUNK_3_NM=CTL22222CXZZ 
Identifies the trunk group termination for the second overflow route. 
 
DTO_SWITCH_3_ID 
Example: DTO_SWITCH_3_ID=002 
Identifies the switch termination for the second overflow route. 
 
DTO_DNIS_3 
Example: DTO_DNIS_3=8000000002 
Identifies the DNIS for the second overflow route. To ensure correct 
file processing, DNIS digits cannot begin with a 0 (zero). Using 0 as 
the lead character in DNIS digits results in the 0 being removed from 
the DNIS as the file is processed. 
 
DTO_ANI 
Example: DTO_ANI=6140000000 
Identifies the ANI for an overflow route. This will be the last route in the 
direct termination overflow (DTO) feature. 

 
Continued on next page 
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Dedicated 8XX Batch File Format Data Dictionary, Continued 

 
Data Record 
Continued 

REALTIME_ANI_IND 
Example: REALTIME_ANI_IND=Y 
Specifies whether or not the customer would like the Real Time ANI 
feature. 
The available options are: 
Y - Yes 
N - No 
 
DNIS_DIGITS 
Example: DNIS_DIGITS=10 
Determines the DNIS expected length. To ensure correct file 
processing, DNIS digits cannot begin with a 0 (zero). Using 0 as the 
lead character in DNIS digits results in the 0 being removed from the 
DNIS as the file is processed. 
 
END_USER_NM 
Example: END_USER_NM=Joe’s Telephone 
Identifies the user responsible for the Toll Free service. 
 
PAYPHONE_BLOCK_IND 
Example: PAYPHONE_BLOCK_IND=Y 
Specifies whether or not the user would like the Payphone Blocking 
feature on the record/order. 
The available options are: 
Y - Yes 
N - No 
 
FEATURE_PERCENT_1 
Example: FEATURE_PERCENT_1=20 
Identifies the percentage of calls the user would like to route to the first 
route. 
The available options are: 
1 – 100% 
 
TRUNK_GRP_NM_1 
Example: TRUNK_GRP_NM_1= CTL00001CXZZ 
Identifies the primary trunk group the Toll Free number will terminate 
to. 
 
SWITCH_ID_1 
Example: SWITCH_ID_1=001 
Identifies primary switch id the Toll Free number will terminate to. 
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Dedicated 8XX Batch File Format Data Dictionary, Continued 

 
Data Record 
Continued 

DNIS_1 
Example: DNIS_1=8000000001 
Identifies primary DNIS the Toll Free number will terminate to. To 
ensure correct file processing, DNIS digits cannot begin with a 0 
(zero). Using 0 as the lead character in DNIS digits results in the 0 
being removed from the DNIS as the file is processed. 
 
TRUNK_GRP_NM_2 
Example: TRUNK_GRP_NM_2=CTL00002CXZZ 
Identifies the second trunk group the Toll Free will terminate to. 
 
SWITCH_ID_2 
Example: SWITCH_ID_2=002 
Identifies second switch id the Toll Free number will terminate to. 
 
DNIS_2 
Example: DNIS_2=8000000002 
Identifies second DNIS the Toll Free number will terminate to. To 
ensure correct file processing, DNIS digits cannot begin with a 0 
(zero). Using 0 as the lead character in DNIS digits results in the 0 
being removed from the DNIS as the file is processed. 
 
TRUNK_GRP_NM_3 
Example: TRUNK_GRP_NM_3=CTL00003CXZZ 
Identifies the third trunk group the Toll Free will terminate to. 
 
SWITCH_ID_3 
Example: SWITCH_ID_3=003 
Identifies third switch id the Toll Free number will terminate to. 
 
DNIS_3 
Example: DNIS_3=8000000003 
Identifies third DNIS the Toll Free number will terminate to. To ensure 
correct file processing, DNIS digits cannot begin with a 0 (zero). Using 
0 as the lead character in DNIS digits results in the 0 being removed 
from the DNIS as the file is processed. 

 
Continued on next page 
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Dedicated 8XX Batch File Format Data Dictionary, Continued 

 
Data Record 
Continued 

DTO_ANI 
Example: DTO_ANI=6140000000 
Identifies the ANI for an overflow route.  This will be the last route in 
the direct termination overflow (DTO) feature. 
 
FEATURE_PERCENT_2 
Example: FEATURE_PERCENT_2=20 
Identifies the percentage of calls the user would like to route to the first 
route. 
The available options are: 
1 – 100% 
 
TRUNK_GRP_NM_1 
Example: TRUNK_GRP_NM_1= CTL00001CXZZ 
Identifies the primary trunk group the Toll Free number will terminate 
to. 
 
SWITCH_ID_1 
Example: SWITCH_ID_1=001 
Identifies primary switch id the Toll Free number will terminate to. 
 
DNIS_1 
Example: DNIS_1=8000000001 
Identifies primary DNIS the Toll Free number will terminate to. To 
ensure correct file processing, DNIS digits cannot begin with a 0 
(zero). Using 0 as the lead character in DNIS digits results in the 0 
being removed from the DNIS as the file is processed. 
 
TRUNK_GRP_NM_2 
Example: TRUNK_GRP_NM_2=CTL00002CXZZ 
Identifies the second trunk group the Toll Free will terminate to. 
 
SWITCH_ID_2 
Example: SWITCH_ID_2=002 
Identifies second switch id the Toll Free number will terminate to. 

 
Continued on next page 
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Dedicated 8XX Batch File Format Data Dictionary, Continued 

 
Data Record 
Continued 

DNIS_2 
Example: DNIS_2=8000000002 
Identifies second DNIS the Toll Free number will terminate to. To 
ensure correct file processing, DNIS digits cannot begin with a 0 
(zero). Using 0 as the lead character in DNIS digits results in the 0 
being removed from the DNIS as the file is processed. 
 
TRUNK_GRP_NM_3 
Example: TRUNK_GRP_NM_3=CTL00003CXZZ 
Identifies the third trunk group the Toll Free will terminate to. 
 
SWITCH_ID_3 
Example: SWITCH_ID_3=003 
Identifies third switch id the Toll Free number will terminate to. 
 
DNIS_3 
Example: DNIS_3=8000000003 
Identifies third DNIS the Toll Free number will terminate to. To ensure 
correct file processing, DNIS digits cannot begin with a 0 (zero). Using 
0 as the lead character in DNIS digits results in the 0 being removed 
from the DNIS as the file is processed. 
 
DTO_ANI 
Example: DTO_ANI=6140000000 
Identifies the ANI for an overflow route. This will be the last route in the 
direct termination overflow (DTO) feature. 
 
FEATURE_PERCENT_3 
Example: FEATURE_PERCENT_3=20 
Identifies the percentage of calls the user would like to route to the first 
route. 
The available options are: 
1 – 100% 
 
TRUNK_GRP_NM_1 
Example: TRUNK_GRP_NM_1= CTL00001CXZZ 
Identifies the primary trunk group the Toll Free number will terminate 
to. 

 
Continued on next page 
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Dedicated 8XX Batch File Format Data Dictionary, Continued 

 
Data Record 
Continued 

SWITCH_ID_1 
Example: SWITCH_ID_1=001 
Identifies primary switch id the Toll Free number will terminate to. 
 
DNIS_1 
Example: DNIS_1=8000000001 
Identifies primary DNIS the Toll Free number will terminate to. To 
ensure correct file processing, DNIS digits cannot begin with a 0 
(zero). Using 0 as the lead character in DNIS digits results in the 0 
being removed from the DNIS as the file is processed. 
 
TRUNK_GRP_NM_2 
Example: TRUNK_GRP_NM_2=CTL00002CXZZ 
Identifies the second trunk group the Toll Free will terminate to. 
 
SWITCH_ID_2 
Example: SWITCH_ID_2=002 
Identifies second switch id the Toll Free number will terminate to. 
 
DNIS_2 
Example: DNIS_2=8000000002 
Identifies second DNIS the Toll Free number will terminate to. To 
ensure correct file processing, DNIS digits cannot begin with a 0 
(zero). Using 0 as the lead character in DNIS digits results in the 0 
being removed from the DNIS as the file is processed. 
 
TRUNK_GRP_NM_3 
Example: TRUNK_GRP_NM_3=CTL00003CXZZ 
Identifies the third trunk group the Toll Free will terminate to. 
 
SWITCH_ID_3 
Example: SWITCH_ID_3=003 
Identifies third switch id the Toll Free number will terminate to. 

 
Continued on next page 
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Dedicated 8XX Batch File Format Data Dictionary, Continued 

 

Data Record 
Continued 

DNIS_3 
Example: DNIS_3=8000000003 
Identifies third DNIS the Toll Free number will terminate to. To ensure 
correct file processing, DNIS digits cannot begin with a 0 (zero). Using 
0 as the lead character in DNIS digits results in the 0 being removed 
from the DNIS as the file is processed. 
 
DTO_ANI 
Example: DTO_ANI=6140000000 
Identifies the ANI for an overflow route.  This will be the last route in 
the direct termination overflow (DTO) feature. 
 
FEATURE_PERCENT_4 
Example: FEATURE_PERCENT_4=20 
Identifies the percentage of calls the user would like to route to the first 
route. 
The available options are: 
1 – 100% 
 
TRUNK_GRP_NM_1 
Example: TRUNK_GRP_NM_1= CTL00001CXZZ 
Identifies the primary trunk group the Toll Free number will terminate 
to. 
 
SWITCH_ID_1 
Example: SWITCH_ID_1=001 
Identifies primary switch id the Toll Free number will terminate to. 
 
DNIS_1 
Example: DNIS_1=8000000001 
Identifies primary DNIS the Toll Free number will terminate to. To 
ensure correct file processing, DNIS digits cannot begin with a 0 
(zero). Using 0 as the lead character in DNIS digits results in the 0 
being removed from the DNIS as the file is processed. 
 
TRUNK_GRP_NM_2 
Example: TRUNK_GRP_NM_2=CTL00002CXZZ 
Identifies the second trunk group the Toll Free will terminate to. 
 
SWITCH_ID_2 
Example: SWITCH_ID_2=002 
Identifies second switch id the Toll Free number will terminate to 
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Dedicated 8XX Batch File Format Data Dictionary, Continued 

 
Data Record 
Continued 

DNIS_2 
Example: DNIS_2=8000000002 
Identifies second DNIS the Toll Free number will terminate to. To 
ensure correct file processing, DNIS digits cannot begin with a 0 
(zero). Using 0 as the lead character in DNIS digits results in the 0 
being removed from the DNIS as the file is processed. 
 
TRUNK_GRP_NM_3 
Example: TRUNK_GRP_NM_3=CTL00003CXZZ 
Identifies the third trunk group the Toll Free will terminate to. 
 
SWITCH_ID_3 
Example: SWITCH_ID_3=003 
Identifies third switch id the Toll Free number will terminate to. 
 
DNIS_3 
Example: DNIS_3=8000000003 
Identifies third DNIS the Toll Free number will terminate to. To ensure 
correct file processing, DNIS digits cannot begin with a 0 (zero). Using 
0 as the lead character in DNIS digits results in the 0 being removed 
from the DNIS as the file is processed. 
 
DTO_ANI 
Example: DTO_ANI=6140000000 
Identifies the ANI for an overflow route. This will be the last route in the 
direct termination overflow (DTO) feature. 
 
FEATURE_PERCENT_5 
Example: FEATURE_PERCENT_5=20 
Identifies the percentage of calls the user would like to route to the first 
route. 
The available options are: 
1 – 100% 
 
TRUNK_GRP_NM_1 
Example: TRUNK_GRP_NM_1= CTL00001CXZZ 
Identifies the primary trunk group the Toll Free number will terminate 
to. 
 
SWITCH_ID_1 
Example: SWITCH_ID_1=001 
Identifies primary switch id the Toll Free number will terminate to. 



November 2016  Control Center User Manual 

 Confidential 49 
Copyright 2016 by CenturyLink. All rights reserved. 

No other use of the material is permitted without the express written consent of CenturyLink. 

Dedicated 8XX Batch File Format Data Dictionary, Continued 

Data Record 
Continued 

DNIS_1 
Example: DNIS_1=8000000001 
Identifies primary DNIS the Toll Free number will terminate to. To 
ensure correct file processing, DNIS digits cannot begin with a 0 
(zero). Using 0 as the lead character in DNIS digits results in the 0 
being removed from the DNIS as the file is processed. 
 
TRUNK_GRP_NM_2 
Example: TRUNK_GRP_NM_2=CTL00002CXZZ 
Identifies the second trunk group the Toll Free will terminate to. 
 
SWITCH_ID_2 
Example: SWITCH_ID_2=002 
Identifies second switch id the Toll Free number will terminate to. 
 
DNIS_2 
Example: DNIS_2=8000000002 
Identifies second DNIS the Toll Free number will terminate to. To 
ensure correct file processing, DNIS digits cannot begin with a 0 
(zero). Using 0 as the lead character in DNIS digits results in the 0 
being removed from the DNIS as the file is processed. 
 
TRUNK_GRP_NM_3 
Example: TRUNK_GRP_NM_3=CTL00003CXZZ 
Identifies the third trunk group the Toll Free will terminate to. 
 
SWITCH_ID_3 
Example: SWITCH_ID_3=003 
Identifies third switch id the Toll Free number will terminate to. 
 
DNIS_3 
Example: DNIS_3=8000000003 
Identifies third DNIS the Toll Free number will terminate to. To ensure 
correct file processing, DNIS digits cannot begin with a 0 (zero). Using 
0 as the lead character in DNIS digits results in the 0 being removed 
from the DNIS as the file is processed. 
 
DTO_ANI 
Example: DTO_ANI=6140000000 
Identifies the ANI for an overflow route. This will be the last route in the 
direct termination overflow (DTO) feature. 

Continued on next page 
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Dedicated 8XX Batch File Format Data Dictionary, Continued 

 
Trailer Record The last line of the file; contains a count that validates the number of 

records preceding it in the file. All parameters of this mandatory line 
must exist as indicated. 
 
RECORD_COUNT 
Example: REC_CNT=5 
Identifies the total number of records in this file. This number 
represents all records/orders in the file excluding the header and 
trailer. If this value does not match the total number of records, the file 
cannot be processed. 
 
TRAILER_IDENTIFIER 
Example: TRAILER_IDENTIFIER=<EOF> 
This is an unchangeable field. The required value for this field is 
<EOF>. 
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Dedicated 8XX Batch File – Upload File 

  
Procedure The 8XX Bulk Add Batch File is loaded into Control Center by either 

uploading it directly into Control Center, or by loading it via the 
CenturyLink Protected Internet Delivery (QPID) utility (for scripted 
uploads to the Control Center folders). Both methods result in the 
Batch File being sent to CenturyLink Wholesale. 
 
Note: You should only use this process for 8XX Bulk Add Batch 
Files. 

 
Step Action 

1  Navigate to Control Center > Orders > Initiate Orders > 
Batch: 

 

Result: The Batch screen appears. 

 

 

Continued on next page 
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Dedicated 8XX Batch File – Upload File, continued 

  
Procedure continued 
 

Step Action 

2  Select Ordering Type as Dedicated: 

Result: Batch screen updates to display links for the 
Formatting Tool and Template for Dedicated 8XX Batch, and 
the Upload File interface. 

 

 

NOTE: “Validate Batch File after Upload” checkbox is 
NEW functionality for November 2016. 
 
If box is checked: all file validations will take place after file 
is uploaded and DIR.LOG will be updated (same behavior 
as in Remote Control). 
 
If box is NOT checked: file validations will be performed 
real time, and errors displayed on the screen (and copied to 
the DIR.LOG file).  File can be corrected AND RENAMED 
and uploaded again. 
 

Continued on next page 
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 Dedicated 8XX Batch File – Upload File, continued 

  
Procedure continued 
 

Step Action 

3  OPTION ONE:  Select (check) the “Validate Batch File 
after Upload” box if real time validation is not desired 
(no validation/error messages on screen). All 
validations will take place after file is uploaded, same 
behavior as Remote Control. 
 

 
 
Click Browse, locate batch file to upload and click Open. 
The file name you selected appears in the Source File field. 
 

 
 
Click Send button. 
Result: pop up message advises file is being processed, 
check DIR.LOG file. 
 

 
 

Continued on next page 
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Dedicated 8XX Batch File – Upload File 

  
Procedure continued 
 

Step Action 

4  OPTION TWO: Leave “Validate Batch File after Upload” 
unchecked if real time validation is desired (error 
messages will appear on screen after file is uploaded). 
 

 
 
Click Browse, locate batch file to upload and click Open. 
The path and file name you selected appears in the Source 
File field. 
Click Send button. 
 
Example of real time validation with messages on screen: 

 

 
 
File can be corrected, RENAMED and uploaded again. 
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Dedicated 8XX Batch Order Status 

 
Procedure Control Center > Orders > Order Status > Preliminary Order Status 

will display each Dedicated Batch file and all its related files. 

The submitted batch file will initially show in Upload 8xx File(s). It will 
move to Archive File when is successfully processed, or to Bad File if 
the entire batch file fails to process. 

The results files that are created from a customer’s Dedicated 8XX 
batch add files (e.g.  Results 01, Results 02, and Results 03) will 
appear under Results Files. 

To review batch file status, complete the following steps: 
 

Step Action 

1  From the Control Center menu bar, select Orders > Order 
Status > Preliminary Order Status 

 
 

2  The Dedicated Batch files are identified by the dedicated 8xx 

batch file name under the Parent Order ID / Batch filename 

column.    The Order Type is always New/Install.  The 

Service Type is always 8XX.  The Ordering Method is 

always Dedicated Batch.  Any of these can be used to 

search/filter the order list.  Please note that the search is 

case sensitive.  Example searches:  08082016CTLTPA.TXT 

or using wildcard: 08082016CTLTPA* or 08082016*, etc. 

 

 

Continued on next page  
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Dedicated 8XX Batch Order Status, continued 

 
Procedure continued 
 

Step Action 

3  To review status of a Dedicated Batch, click the batch file 

name link under the Parent Order ID / Batch Filename 

column, and an overlay will display the information for that 

dedicated batch file. 

 

There are three tabs, Order Details, 8XX Details and Files.   

4  The Order Details tab provides the following information: 

 

 
5  The 8XX Details tab provides the following information: 

 

 
 

Continued on next page 
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 Dedicated 8XX Batch Order Status, continued 

 
Procedure continued 
 

Step Action 

6  The Files tab will have a similar appearance to Remote 

Control, where the Results Files, Bad File, Archive File and 

Upload 8XX File (with DIR.LOG) directories are displayed. 

 

 
 

7  Click the filename link to download a file. 

 
8  Select Open or Save (drop down menu includes Save, 

Save As, Save and open options), depending on if the file 
is to be opened or saved to the user’s computer. 
 

Continues on next page 
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Dedicated 8XX Batch Order Status, continued 

 
Procedure continued 
 

Step Action 

9  The Orion Order ID and Core Order ID shown on the 8XX 

Details tab in Preliminary Order Status: 

 

…can be reviewed in Control Center > Orders > Order 

Status > Post-Submission Order Status. 

 

(Note: this is the Order Status that has been available in Control 

Center since 2010.  It was renamed to Post-Submission Order 

Status when Remote Control/RMC Ordering and Order Status 

was migrated into Control Center in November 2016.) 

 

10  Copy or make note of the Orion or Core Order ID, then 

navigate to Control Center > Orders > Order Status > Post-

Submission Order Status. 

 

In the “Search for…” drop down menu of the Post-

Submission Order Status page, select Parent Order ID.  The 

Search field will appear, enter the Orion order number.  Or 

select Sales Order ID(s) and enter the Core sales order 

number.  You can use enter key on your keyboard or click 

the icon to the right of the Search field.  

 

 
 

Continues on next page 
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Dedicated 8XX Batch Order Status, continued 

 
Procedure continued 
 

Step Action 

11  Click the order number link under the Parent Order ID 

column, and an overlay will appear: 

 

The Order Details tab provides the following information: 

 
 

12  The Sales and Provisioning Orders tab provides the 

following information: 

 

 
 

Continues on next page 
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Dedicated 8XX Batch Order Status, continued 

 
Procedure continued 
 

Step Action 

13  Click the order number link under the 

Engineering/Provisioning Orders for Sales Order section, 

found under the Tracking# column.  Milestone job steps will 

be shown (varies depending on the service/product 

provisioned on the order): 

 

 
 

 

14  Utilize the Back button in the bottom left hand corner to 

return to the Order Details and Sales and Provisioning 

Orders tabs. 

 



November 2016  Control Center User Manual 

 Confidential 61 
Copyright 2016 by CenturyLink. All rights reserved. 

No other use of the material is permitted without the express written consent of CenturyLink. 

Dedicated 8XX Batch File Error Handling 

 
8XX 
Submitted 
Order Rejects 
for Bulk Add 
Orders 

This section describes the actions required by the Customer and/or 
Service Delivery Representative when an error message is received 
during the Bulk Add Order Entry or Provisioning process. 
 
The information is separated into three sections: Batch File Format 
Validation Errors, Batch File Submit Validation Errors and Batch 
File Submit Network Errors. Each section provides the responsible 
party, error message, reasons for receiving the error message, 
required actions to resolve the error, and location of error. 
 
If more information is required surrounding the Bulk Add ordering 
process, please contact your Service Delivery Representative. 
 
Policies: 

 Access to the Bulk Add ordering functionality is required prior to 
submitting a Bulk Add order; via either Control Center access or 
through an FTP Client requiring username/password 

 Access must be requested in writing through the Service Delivery 
Representative 

 CenturyLink is not responsible for service degradation, including 
outages, caused by customer-initiated requests via the Bulk 
Change or Bulk Add tools 

 
Additional Information: 

 The system will process all valid records and will provide error-
related information for any invalid records submitted in the DIR.log, 
‘Results 01,’ ‘Results 02,’ and ‘Results 03’ files. Batch file validation 
errors will be contained in the DIR.log as well as in the Load Errors 
sections of each results file 

 Files must include a requested due date greater than the day the 
order is submitted 

 Orders for Dedicated numbers, including Simple and Enhanced 
8XX numbers, can be submitted through this tool. 

 
Continued on next page 
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Dedicated 8XX Batch File Error Handling, Continued 

  
Batch File 
Format 
Validation 
Errors 

The table below describes the batch file format validation errors you 
may see. 

  

Item 
Action 

Required 
By 

Error Message 
Reason for Error 

Message 
Action Required 

D
IR

.l
o

g
 

R
e
s
u

lt
s
 0

1
 

R
e
s
u

lt
s
 0

2
 

R
e
s
u

lt
s
 0

3
 

1  Customer “Generic Message: 
Encountered the 
problem in the 
following record.” 

The 8XX number 
encountered a generic error 
that entails format errors 
which can consist of alpha 
vs. numeric or data record 
length 

Customer must correct 
any file or field format 
errors 

Yes No No No 

2  Customer “8XX number is a 
duplicate. Please 
correct and 
resubmit.” 

The 8XX number is found 
more than once in the file 

Customer must enter a 
unique 8XX 

If customer entered 
8XX in error, no action 
is needed 

Yes No No No 

3  Customer “8XX has an 
invalid Class of 
Service on record. 
Please correct 
and resubmit.” 

8XX number contains a 
Class of Service value 
that does not equal 2 
numeric characters 

Class of Service value 
must exist within the 
CenturyLink systems 

8XX Class of Service 
value must not equal 
‘9XX’ 

8XX Class of Service 
value must not equal 
‘international’ 

Class of Service value 
must not equal a shared 
traffic COS 

Customer must enter a 
class of service that 
equals 2 valid numeric 
characters 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

4  Customer “8XX has an 
invalid 
Termination 
Method defined 
on record. Please 
correct and 
resubmit.” 

8XX number contains a 
Termination Method 
value that exceeds 3 
alpha characters 

8XX number contains a 
Termination Method 
value that does not equal 
DED or OCC 

Customer must enter a 
valid termination 
method value that 
equals “DED” or “OCC” 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

5  Customer “8XX has an 
invalid Switch ID 
defined on record. 
Please correct 
and resubmit.” 

8XX number contains a 
primary Switch ID value 
that does not equal 3 
numeric characters 

Customer must enter a 
valid switch id value 
that equals 3 numeric 
characters 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

 
Continued on next page 
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Dedicated 8XX Batch File Error Handling, Continued 

  
Batch File Format Validation Errors (continued) 

 

Item 
Action 
Required 
By 

Error Message 
Reason for Error 
Message 

Action Required 
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6  Customer “8XX has an invalid 
Trunk Group 
defined on record. 
Please correct and 
resubmit.” 

8XX number contains a 
primary trunk name value 
that does not equal 12 
alpha/numeric characters 

8XX must be a valid 
NPA/NXX combination for 
the primary trunk name 

Trunk Group Name must 
exist in F&E, Prod Billing 
and the Switch Id 

Customer must enter a 
valid trunk name value 
that equals 12 
alpha/numeric 
characters 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

7  Customer “Invalid Customer 
ID/Batch ID 
defined for file. 
Please correct and 
resubmit.” 

Batch file header contains 
a Batch ID value that does 
not equal 3 or 4 
alpha/numeric characters 

The submitted file (in Bad 
files) does not have tabs in 
the header 

The FTP Client may be set 
to "Smart" or "ASCII" 
instead of "Binary" 

The header has lost all 
tabs and therefore failed 
the validation 

Customer must enter a 
valid batch id value that 
equals 3 or 4 
alpha/numeric 
characters 

Correct the FTP Client 
setting to “Binary” 

Yes No No No 

8  Customer “Invalid Batch Type 
defined for file. 
Please correct and 
resubmit.” 

Batch file header contains 
a batch type value that 
does not equal 7 alpha/ 
numeric characters 

Batch file header contains 
a batch type value that 
does not equal BT_WH8A 

Customer must enter a 
valid batch type value 
that equals “BT_WH8A” 

Yes No No No 

9  Customer “Invalid File Date 
defined for file. 
Please correct and 
resubmit.” 

Batch file header contains 
a file date value that does 
not equal 8 numeric 
characters 

Customer must enter a 
valid file date value that 
equals 8 numeric 
characters 

Yes No No No 

10  Customer “Invalid Submit 
Date defined for 
file. Please correct 
and resubmit.” 

Batch file header contains 
a submit date value that 
exceeds 8 numeric 
characters 

Customer must enter a 
valid submit date value 
that equals 8 numeric 
characters 

Yes No No No 

11  Customer “Invalid Order ID 
defined for file. 
Please correct and 
resubmit.” 

Batch file header contains 
a order id value that 
exceeds 15 alpha/numeric 
characters 

Customer must enter a 
valid order id value that 
does not exceed 15 
alpha/numeric 
characters 

Yes No No No 

 
Continued on next page 
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Dedicated 8XX Batch File Error Handling, Continued 

 Batch File Format Validation Errors (continued) 

 

Item 
Action 
Required 
By 

Error Message 
Reason for Error 
Message 

Action Required 
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12  Customer “Invalid Primary 
Contact Name 
defined for file. 
Please correct and 
resubmit.” 

Batch file header contains 
a primary contact name 
value that exceeds 30 
alpha/numeric characters 

Customer must enter a 
valid primary contact 
name value that does 
not exceed 30 
alpha/numeric 
characters 

Yes No No No 

13  Customer “Invalid Primary 
Contact Email 
defined for file. 
Please correct and 
resubmit.” 

Batch file header contains 
a primary contact email 
value that exceeds 60 
alpha/numeric characters 

Customer must enter a 
valid primary contact 
email value that does 
not exceed 60 
alpha/numeric 
characters 

Yes No No No 

14  Customer “Primary Contact 
Phone number 
does not equal 10 
numeric digits. 
Please correct and 
resubmit.” 

Batch file header contains 
a primary contact phone 
value that does not equal 
10 numeric characters 

Customer must enter a 
valid primary contact 
phone value that equals 
10 numeric characters 

Yes No No No 

15  Customer “Invalid Primary 
Ext defined for file. 
Please correct and 
resubmit.” 

Batch file header contains 
a primary ext value that 
exceeds 4 numeric 
characters 

Customer must enter a 
valid primary ext value 
that does not exceed 4 
numeric characters 

Yes No No No 

16  Customer “Invalid Primary 
Country defined for 
file. Please correct 
and resubmit.” 

Batch file header contains 
a primary country value 
that does not equal 3 
alpha characters 

Customer must enter a 
valid primary country 
value that equals 3 
alpha characters 

Yes No No No 

17  Customer “Invalid Primary 
Contact Dial Code 
defined for file. 
Please correct and 
resubmit.” 

Batch file header contains 
a primary contact dial code 
value that exceeds 4 
numeric characters 

Customer must enter a 
valid primary contact 
dial code value that 
does not exceed 4 
numeric characters 

Yes No No No 

18  Customer “Invalid Secondary 
Contact Phone 
number defined for 
file. Please correct 
and resubmit.” 

Batch file header contains 
a secondary contact phone 
value that does not equal 
10 numeric characters 

Customer must enter a 
valid secondary contact 
phone value that equals 
10 numeric characters 

Yes No No No 

19  Customer “Invalid Secondary 
Ext. defined for file. 
Please correct and 
resubmit.” 

Batch file header contains 
a secondary ext value that 
exceeds 4 numeric 
characters 

Customer must enter a 
valid secondary ext 
value that does not 
exceed 4 numeric 
characters 

Yes No No No 

20  Customer “Invalid Fax 
number defined for 
file. Please correct 
and resubmit.” 

Batch file header contains 
a fax value that does not 
equal 10 numeric 
characters 

Customer must enter a 
valid fax value that 
equals 10 numeric 
characters 

Yes No No No 

21  Customer “Invalid Company 
Name defined for 
file. Please correct 
and resubmit.” 

Batch file header contains 
a company name value 
that exceeds 35 
alpha/numeric characters 

Customer must enter a 
valid company name 
value that does not 
exceed 35 
alpha/numeric 
characters 

Yes No No No 

Continued on next page 
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Dedicated 8XX Batch File Error Handling, Continued 

  
Batch File Format Validation Errors (continued) 

 

Item 
Action 
Required 
By 

Error Message 
Reason for Error 
Message 

Action Required 
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22  Customer “Invalid Account 
Manager name 
defined for file. 
Please correct and 
resubmit.” 

Batch file header contains 
a account manager name 
value that exceeds 30 
alpha/numeric characters 

Customer must enter a 
valid account manager 
name value that does 
not exceed 30 
alpha/numeric 
characters 

Yes No No No 

23  Customer “Invalid Customer 
PON defined for 
file. Please correct 
and resubmit.” 

Batch file header contains 
a customer PON value that 
exceeds 16 alpha/numeric 
characters 

Customer must enter a 
valid customer PON 
value that does not 
exceed 16 
alpha/numeric 
characters 

Yes No No No 

24  Customer “Invalid Related 
Customer PON 
defined for file. 
Please correct and 
resubmit.” 

Batch file header contains 
a related customer PON 
value that exceeds 16 
alpha/numeric characters 

Customer must enter a 
valid related customer 
PON value that does not 
exceed 16 
alpha/numeric 
characters 

Yes No No No 

25  Customer “Invalid Requested 
Due Date defined 
for file. Please 
correct and 
resubmit.” 

Batch file header contains 
a desired due date value 
that does not equal 8 
numeric characters 

Customer must enter a 
valid desired due date 
value that equals 8 
numeric characters 

Yes No No No 

26  Customer “8XX has an invalid 
Customer Account 
ID defined on 
record. Please 
correct and 
resubmit.” 

8XX number contains a 
customer account ID value 
that exceeds 12 numeric 
characters 

Customer must enter a 
valid customer account 
ID value that does not 
exceed 12 numeric 
characters 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

27  Customer “8XX has an invalid 
Product Account ID 
on record. Please 
correct and 
resubmit.” 

8XX number contains a  
product account ID value 
that exceeds 12 numeric 
characters 

Customer must enter a 
valid product account ID 
value that does not 
exceed 12 numeric 
characters 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

28  Customer “8XX has an invalid 
Action Code 
defined on record. 
Please correct and 
resubmit.” 

8XX number contains an 
action code value that 
does not equal 1 alpha 
character 

8XX number contains an 
action code value that 
does not equal A (Add) 

Customer must enter a 
valid action code value 
that equals “A” 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 
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Dedicated 8XX Batch File Error Handling, Continued 

  
Batch File Format Validation Errors (continued) 

 

Item 
Action 
Required 
By 

Error Message 
Reason for Error 
Message 

Action Required 
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29  Customer “8XX has an invalid 
Component Group 
Code defined on 
record. Please 
correct and 
resubmit.” 

8XX number contains a 
component group code 
value that does not equal 2 
alpha characters 

8XX number contains a 
component group code 
value that does not equal 
IW 

Customer must enter a 
valid component group 
code value that equals 
“IW” 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

30  Customer “8XX has an invalid 
Customer Type 
defined on record. 
Please correct and 
resubmit.” 

8XX number contains a 
customer type value that 
does not equal 1 alpha 
character 

8XX number contains a 
customer type value that 
does not equal B or R 

Customer must enter a 
valid customer type 
value that equals “B” or 
“R” 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

31  Customer “8XX has an invalid 
LOA Date defined 
on record. Please 
correct and 
resubmit.” 

8XX number contains a 
LOA date value that does 
not equal 8 numeric 
characters 

8XX number contains a 
LOA date value that 
exceeds 25 calendar days 

8XX number contains a 
LOA date value that is not 
greater than the previous 
LOA date or greater that 
the system date 

Customer must enter a 
valid LOA date value 
that equals 8 numeric 
characters 

Customer must enter a 
valid LOA date value 
that does not exceed 25 
calendar days 

Customer must enter a 
valid LOA date value 
that is not greater than 
the previous LOA date 
or greater that the 
system date 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

32  Customer “8XX has an invalid 
RespOrg ID 
defined on record. 
Please correct and 
resubmit.” 

8XX number contains a 
RespOrg ID value does 
not equal 5 alpha/numeric 
characters 

Customer must enter a 
valid RespOrg ID value 
that equals 5 
alpha/numeric 
characters 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

33  Customer “8XX has an invalid 
Area of Service 
defined on record. 
Please correct and 
resubmit.” 

8XX number contains an 
area of service value that 
does not equal 2 alpha 
characters 

Customer must enter a 
valid area of service 
value that equals 2 
alpha characters 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

34  Customer “8XX has an invalid 
Comment length 
defined on record. 
Please correct and 
resubmit.” 

8XX number contains a 
comment value that 
exceeds 2000 alpha/ 
numeric characters 

Customer must enter a 
valid comments value 
that does not exceed 
2000 alpha/numeric 
characters 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 
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Dedicated 8XX Batch File Error Handling, Continued 

  
Batch File Format Validation Errors (continued) 

 

Item 
Action 
Required 
By 

Error Message 
Reason for Error 
Message 

Action Required 
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35  Customer “8XX has an invalid 
DNIS defined on 
record. Please 
correct and 
resubmit.” 

8XX number contains a  
DNIS value that exceeds 
10 numeric characters 

Customer must enter a 
valid DNIS value that 
does not exceed 10 
numeric characters 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

36  Customer “8XX has an invalid 
DTO Trunk Group 
defined on record. 
Please correct and 
resubmit.” 

8XX number contains a 
DTO trunk name value that 
does not equal 12 
alpha/numeric characters 

Customer must enter a 
valid DTO trunk name 
value that equals 12 
alpha/numeric 
characters 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

37  Customer “8XX has an invalid 
DTO Switch ID 
defined on record. 
Please correct and 
resubmit.” 

8XX number contains a 
DTO switch ID value that 
does not equal 3 numeric 
characters 

Customer must enter a 
valid DTO switch ID 
value that equals 3 
numeric characters 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

38  Customer “8XX has an invalid 
DTO ANI defined 
on record. Please 
correct and 
resubmit.” 

8XX number contains a 
DTO ANI value that does 
not equal 10 numeric 
characters 

Customer must enter a 
valid DTO ANI value 
that equals 10 numeric 
characters 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

39  Customer “8XX has an invalid 
Real Time ANI 
indicator defined 
on record. Please 
correct and 
resubmit.” 

8XX number contains a 
real time ANI indicator 
value that does not equal 1 
alpha character 

8XX number contains a 
real time ANI value that 
does not equal "Y" (Yes) 
or "N" (No) 

Customer must enter a 
valid real time ANI 
indicator value that 
equals "Y" (Yes) or "N" 
(No) 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

40  Customer “8XX has an invalid 
DNIS Digits length 
defined on record. 
Please correct and 
resubmit.” 

8XX number contains a 
DNIS digits value that 
does not equal 2 numeric 
characters 

8XX number contains a 
DNIS digits value that 
does not equal the length 
provided in the DNIS value 
fields 

Customer must enter a 
valid DNIS digits value 
that equals 2 numeric 
characters 

Customer must enter a 
valid DNIS digits value 
that equals the length 
provided in the DNIS 
value fields 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

41  Customer “8XX has an invalid 
End User Name 
defined on record. 
Please correct and 
resubmit.” 

8XX number contains an 
end user name value that 
exceeds 35 alpha/numeric 
characters 

Customer must enter a 
valid end user name 
value that does not 
exceed 35 
alpha/numeric 
characters 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 
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Dedicated 8XX Batch File Error Handling, Continued 

  
Batch File Format Validation Errors (continued) 

 

Item 
Action 
Required 
By 

Error Message 
Reason for Error 
Message 
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42  Customer 
 

“8XX has an invalid 
Payphone Blocking 
indicator defined 
on record. Please 
correct and 
resubmit.” 

 8XX number contains a 
payphone blocking 
indicator value that 
does not equal 1 alpha 
character 

 8XX number contains a 
payphone blocking 
indicator value that 
does not equal "Y" 
(Yes) or "N" (No) 

Customer must enter a 
valid payphone blocking 
indicator value that 
equals "Y" (Yes) or "N" 
(No) 

Yes Yes 
With a 
valid 

record 

Yes 
With a 
valid 

record 

Yes 
With a 
valid 

record 

43  Customer “8XX has an invalid 
Feature Percent 
defined on record. 
Please correct and 
resubmit.” 

 8XX number contains a 
feature percent value 1, 
2, 3, 4, or 5 that 
exceeds 3 numeric 
characters 

 8XX number contains a 
feature percent 1, 2, 3, 
4, or 5 value or 
combination of values 
that do not equal 100% 

 Customer must enter 
a valid feature 
percent value 1, 2, 3, 
4, or 5 that does not 
exceed 3 numeric 
characters 

 Customer must enter 
a valid feature 
percent 1, 2, 3, 4, or 
5 value or 
combination of 
values that equal 
100% 

Yes Yes 
With a 
valid 

record 

Yes 
With a 
valid 

record 

Yes 
With a 
valid 

record 

44  Customer “8XX has an invalid 
% Trunk Group 
Name defined on 
record. Please 
correct and 
resubmit.” 

8XX number contains a % 
trunk group name value 
that does not equal 12 
alpha/numeric characters 

Customer must enter a 
valid % trunk group 
name value that equals 
12 alpha/numeric 
characters 

Yes Yes 
With a 
valid 

record 

Yes 
With a 
valid 

record 

Yes 
With a 
valid 

record 

45  Customer/ 
SDR 

“8XX has an invalid 
% Switch ID 
defined on record. 
Please correct and 
resubmit.” 

 8XX number contains a 
% Switch ID value that 
does not equal 3 
numeric characters 

 8XX number contains a 
% Switch ID value that 
does not match the 
switch ID for the trunk 
group provided in the 
file 

 Customer must enter 
a valid % Switch ID 
value that equals 3 
numeric characters 

 Customer must enter 
a valid % Switch ID 
value that matches 
the switch ID for the 
trunk group name, 
contact your SDR for 
assistance 

 Service Delivery 
Representative will 
investigate the status 
of the switch id and 
trunk group and 
provide the data 
needed to the 
customer 

 Customer will submit 
new request when 
issue is resolved 

Yes Yes 
With a 
valid 

record 

Yes 
With a 
valid 

record 

Yes 
With a 
valid 

record 
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Dedicated 8XX Batch File Error Handling, Continued 

  
Batch File Format Validation Errors (continued) 

 

Item 
Action 
Required 
By 

Error Message 
Reason for Error 
Message 

Action Required 
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46  Customer “8XX has an invalid 
% DNIS defined on 
record. Please 
correct and 
resubmit.” 

8XX number contains a % 
DNIS value that exceeds 
10 numeric characters 

Customer must enter a 
valid % DNIS value that 
does not exceed 10 
numeric characters 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

47  Customer “8XX has an invalid 
%DTO ANI defined 
on record. Please 
correct and 
resubmit.” 

8XX number contains a % 
DTO ANI value that does 
not equal 10 numeric 
characters 

Customer must enter a 
valid % DTO ANI value 
that equals 10 numeric 
characters 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

48  Customer/ 

SDR 

“8XX has a % 
Trunk Group Name 
defined on record 
that is not In 
Service/Active. 
Please correct and 
resubmit.” 

8XX number contains a % 
trunk group value that is 
not found "In Service" 

Customer must enter a 
valid % trunk group 
value that is not pending 
turn-up or is 
disconnected 

If the trunk group should 
be active, contact your 
account manger for 
assistance 

The Service Delivery 
Representative will 
investigate the status of 
the trunk group and 
provide assistance to 
resolve 

Customer will submit 
new request when issue 
is resolved 

No Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes - 
With a 
valid 
record 

49  Customer “Invalid Record 
Count defined on 
file. Please correct 
and resubmit.” 

Batch file trailer contains a 
record count value that 
exceeds 12 numeric 
characters 

Batch file trailer contains a 
record count value that 
does not equal actual 
record count in the file 

Customer must enter a 
valid record count value 
that does not exceed 12 
numeric characters 

Customer must enter a 
valid record count value 
that equals actual 
record count in the file 

Yes No No No 

50  Customer “Invalid Trailer 
Identifier defined 
on file. Please 
correct and 
resubmit.” 

Batch file trailer contains a 
trailer identifier value that 
does not equal <EOF> 

Customer must enter a 
valid trailer identifier 
value that equals 
<EOF> 

Yes No No No 

51  Customer “8XX has an invalid 
Order Type defined 
on record. Please 
correct and 
resubmit.” 

8XX number contains an 
order type value that does 
not equal "N" (New) or "C" 
(Compl) 

Customer must enter a 
valid order type value 
that equals "N" (New) or 
"C" (Compl) 

Yes Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 

Yes 

With a 
valid 
record 
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Dedicated 8XX Batch File Error Handling, Continued 

  

Batch File Format Validation Errors (continued) 
 

Item 
Action 
Required 
By 

Error Message 
Reason for Error 
Message 

Action Required 
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52  Customer “8XX must have a 
Trunk Group and 
Switch ID defined 
on record. Please 
correct and 
resubmit.” 

8XX number contains a 
termination method of 
dedicated; however no 
dedicated route was found 

Customer must enter a 
valid trunk group name 
and switch id when the 
termination method id 
DED or OCC 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

53  Customer “Invalid file format 
defined for File 
Date.  Please 
correct and 
resubmit.” 

Batch file header contains 
a file date value that does 
not equal the YYYYMMDD 
date format 

Customer must enter a 
valid file date value that 
is consistent with the 
YYYYMMDD date 
format 

Yes No No No 

54  Customer “Invalid file format 
defined for Submit 
Date. Please 
correct and 
resubmit.” 

Batch file header contains 
a submit date value that 
does not equal the 
YYYYMMDD date format 

Customer must enter a 
valid submit date value 
that is consistent with 
the YYYYMMDD date 
format 

Yes No No No 

55  Customer “Invalid file format 
defined for 
Requested Due 
Date. Please 
correct and 
resubmit.” 

Batch file header contains 
a desired due date value 
that does not equal the 
YYYYMMDD date format 

Customer must enter a 
valid desired due date 
value that is consistent 
with the YYYYMMDD 
date format 

Yes No No No 

56  Customer “8XX has an invalid 
file format defined 
for LOA date. 
Please correct and 
resubmit.” 

8XX number contains a 
LOA date value that does 
not equal the YYYYMMDD 
date format 

Customer must enter a 
valid LOA date value 
that is consistent with 
the YYYYMMDD date 
format 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

57  Customer “Record does not 
contain an 8XX. 
Please correct and 
resubmit.” 

8XX has not been defined 
in the file 

Customer must enter a 
unique 8XX value for 
each data record in the 
file 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

58  Customer “8XX has no 
Carrier To Be 
RespOrg indicator 
defined on record. 
Please correct and 
resubmit.” 

8XX number does not 
contain a CenturyLink to 
be RespOrg value in the 
file 

Customer must enter a 
valid Carrier to be 
RespOrg ID value for 
each data record in the 
file 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

59  Customer “No Customer 
ID/Batch ID 
defined for file. 
Please correct and 
resubmit.” 

Batch file header does not 
contains a batch ID value 
in the file 

Customer must enter a 
valid batch ID value in 
the header record 

Yes No No No 

60  Customer “No Batch Type 
defined for file. 
Please correct and 
resubmit.” 

Batch file header does not 
contains a batch type 
value in the file 

Customer must enter a 
valid batch type value in 
the header record 

Yes No No No 

61  Customer “No File Date 
defined for file. 
Please correct and 
resubmit.” 

Batch file header does not 
contains a file date value 
in the file 

Customer must enter a 
valid file date value in 
the header record 

Yes No No No 
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Dedicated 8XX Batch File Error Handling, Continued 

  

Batch File Format Validation Errors (continued) 
 

Item 
Action 
Required 
By 

Error Message 
Reason for Error 
Message 

Action Required 
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62  Customer “No Submit Date 
defined for file. 
Please correct and 
resubmit.” 

Batch file header does not 
contains a submit date 
value in the file  

Customer must enter a 
valid submit date value 
in the header record 

Yes No No No 

63  Customer “No Primary 
Contact Name 
defined for file. 
Please correct and 
resubmit.“ 

Batch file header does not 
contains a primary contact 
name value in the file 

Customer must enter a 
valid primary contact 
name value in the 
header record 

Yes No No No 

64  Customer “No Primary 
Contact Email 
defined for file. 
Please correct and 
resubmit. “ 

Batch file header does not 
contain a primary contact 
email value in the file 

Customer must enter a 
valid primary contact 
email address value in 
the header record 

Yes No No No 

65  Customer “No Primary 
Contact Phone 
number defined for 
file. Please correct 
and resubmit.” 

Batch file header does not 
contains a primary contact 
phone value in the file 

Customer must enter a 
valid primary contact 
phone number value in 
the header record 

Yes No No No 

66  Customer “No Company 
Name defined for 
file. Please correct 
and resubmit.” 

Batch file header does not 
contains a company name 
value in the file 

Customer must enter a 
valid company name 
value in the header 
record 

Yes No No No 

67  Customer “No Account 
Manager name 
defined for file. 
Please correct and 
resubmit.” 

Batch file header does not 
contains a account manger 
name value in the file  

Customer must enter a 
valid account manager 
name value in the 
header record 

Yes No No No 

68  Customer “No Requested 
Due Date defined 
for file. Please 
correct and 
resubmit.” 

Batch file header does not 
contains a desired due 
date value in the file 

Customer must enter a 
valid requested due 
date value in the header 
record 

Yes No No No 

69  Customer “8XX has no 
Customer Account 
ID defined on 
record. Please 
correct and 
resubmit.” 

8XX number does not 
contain a customer 
account ID value in the file 

Customer must enter a 
valid Customer Account 
ID value for each data 
record in the file 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

70  Customer “8XX has no 
Product Account ID 
defined on record. 
Please correct and 
resubmit.” 

8XX number does not 
contain a product account 
ID value in the file  

Customer must enter a 
valid product account ID 
value for each data 
record in the file 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

71  Customer “8XX has no Action 
Code defined on 
record. Please 
correct and 
resubmit.” 

8XX number does not 
contain an action code 
value in the file  

Customer must enter a 
valid action code value 
for each data record in 
the file 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 
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Dedicated 8XX Batch File Error Handling, Continued 

  
Batch File Format Validation Errors (continued) 
 

Item 
Action 
Required 
By 

Error Message 
Reason for Error 
Message 

Action Required 
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72  Customer “8XX has no 
Component Group 
Code defined on 
record. Please 
correct and 
resubmit.” 

8XX number does not 
contain a component 
group code value in the file  

Customer must enter a 
valid component group 
code value for each 
data record in the file 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

73  Customer “8XX has no 
Customer Type 
defined on record. 
Please correct and 
resubmit.” 

8XX number does not 
contain a customer type 
value in the file 

Customer must enter a 
valid customer type 
value for each data 
record in the file 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

74  Customer “8XX has no LOA 
Date defined on 
record. Please 
correct and 
resubmit.” 

8XX number does not 
contain a LOA date value 
in the file 

Customer must enter a 
valid LOA date value for 
each data record in the 
file 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

75  Customer “8XX has no 
RespOrg ID 
defined on record.  
Please correct and 
resubmit.” 

8XX number does not 
contain a RespOrg ID 
value in the file 

Customer must enter a 
valid RespOrg ID value 
for each data record in 
the file 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

76  Customer “8XX has no Area 
of Service defined 
on record. Please 
correct and 
resubmit.” 

8XX number does not 
contain an area of service 
value in the file 

Customer must enter a 
valid area of service 
value for each data 
record in the file 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

77  Customer “8XX has no Real 
Time ANI indicator 
defined on record. 
Please correct and 
resubmit.” 

8XX number does not 
contain a real time ANI 
indicator value in the file 

Customer must enter a 
valid real time ANI 
indicator value for each 
data record in the file 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

78  Customer “8XX has no End 
User Name defined 
on record. Please 
correct and 
resubmit.” 

8XX number does not 
contain an end user name 
value in the file 

Customer must enter a 
valid end user name 
value for each data 
record in the file 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

79  Customer “8XX has no 
Payphone Blocking 
indicator defined 
on record. Please 
correct and 
resubmit.” 

8XX number does not 
contain a payphone 
blocking indicator value in 
the file 

Customer must enter a 
valid payphone blocking 
indicator value for each 
data record in the file 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

80  Customer “No Record Count 
defined on file. 
Please correct and 
resubmit.” 

Batch file trailer does not 
contains record count 
value in the file 

Customer must enter a 
valid record count value 
in the trailer record 

Yes No No No 
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Dedicated 8XX Batch File Error Handling, Continued 

  

Batch File Format Validation Errors (continued) 
 

Item 
Action 
Required 
By 

Error Message 
Reason for Error 
Message 

Action Required 
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81  Customer “No Trailer 
Identifier defined 
on file. Please 
correct and 
resubmit.” 

Batch file trailer does not 
contains a trailer identifier 
value in the file 

Customer must enter a 
valid trailer identifier 
value in the trailer 
record 

Yes No No No 

82  Customer “8XX has no Class 
of Service defined 
on record. Please 
correct and 
resubmit.” 

8XX number does not 
contain a class of service 
value in the file 

Customer must enter a 
valid class of service 
value for each data 
record in the file 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

83  Customer “8XX has no 
termination method 
defined on record.  
Please correct and 
resubmit.” 

8XX number does not 
contain a termination 
method value in the file 

Customer must enter a 
valid termination method 
value for each data 
record in the file 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

84  Customer “8XX has no Order 
Type defined on 
record. Please 
correct and 
resubmit.” 

8XX number does not 
contain an order type 
value in the file 

Customer must enter a 
valid order type value 
for each data record in 
the file 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

85  Customer “8XX does not 
equal 10 digits. 
Please correct and 
resubmit.” 

8XX number contains a 
value that is not equal to 
10 digits 

Customer must enter a 
valid 8XX value that 
equals 10 numeric 
characters 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

86  Customer “8XX must contain 
only numeric 
characters.  Please 
correct and 
resubmit.” 

8XX number contains a 
value that is not equal to 
numeric characters 

Customer must enter a 
valid 8XX value that 
equals numeric 
characters 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

87  Customer “8XX contains an 
invalid CenturyLink 
to Be RespOrg 
indicator. Please 
correct and 
resubmit.” 

8XX number contains a 
CenturyLink to be 
RespOrg value that does 
not equal the order type 
requested 

8XX number contains a 
CenturyLink to be 
RespOrg value that does 
not equal “Y” (Yes) or “N” 
(No) 

Customer must enter a 
valid CenturyLink to be 
RespOrg indicator value 
that equals “Y” (Yes) 
when CenturyLink will 
be RespOrg and “N” 
(No) when the Carrier 
will be a 
Complementary 
RespOrg 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

88  Customer “8XX has no 
Switch ID defined 
on record. Please 
correct and 
resubmit.” 

8XX number does not 
contain a switch id value in 
the file 

Customer must enter a 
valid switch id value for 
each data record in the 
file 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

89  Customer “8XX has no Trunk 
Group defined on 
record. Please 
correct and 
resubmit.” 

8XX number does not 
contain a trunk group 
value in the file 

Customer must enter a 
valid trunk group value 
for each data record in 
the file 

Yes Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 

Yes - 
With a 
valid 
record 
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Dedicated 8XX Batch File Error Handling, Continued 

  
Batch File 
Submit 
Validation 
Errors 

The table below describes batch file submit validation errors you may 
see. 
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1  Customer “8XX has an invalid 
prefix. Please 
correct and 
resubmit.” 

8XX number does not 
contain a valid 'XX' 
portion of the 8XX 
number (i.e. 888, 
877, 800, etc.) 

Customer must enter a valid 
8XX value that contains the 
correct prefix of 800, 888, 
877, 866, 855, 844, etc 

No Yes Yes Yes 

2  Customer “8XX already exists 
on your account.” 

8XX number already 
exists on the 
customer 
account/product 
account ID defined in 
the file 

Customer must enter a 
unique 8XX for each file 

If customer entered 8XX in 
error, no action is needed 

No Yes Yes Yes 

3  Customer
/ 

SDR 

“The given 8xx is on 
another open order. 
Please contact your 
Account Manager 
for assistance. 
System: XXXX." 

8XX number is found 
on another 
CenturyLink order 

Service Delivery 
Representative will 
investigate the open order 
and determine if the order 
should be closed, cancelled, 
or escalated for completion 

Customer will submit new 
request when issue is 
resolved 

If customer entered 8XX in 
error, no action is needed 

No Yes Yes Yes 

4  Customer
/ 

SDR 

“8XX is not 
reserved. Please 
reserve 8XX and 
resubmit.” 

8XX number does not 
have an active 
reservation 

Service Delivery 
Representative will 
investigate the status of the 
reservation and determine if 
the 8XX can be reserved 
and provided the customer 

If the 8XX reservation has 
been lost to another carrier 
the customer will need to 
reserve a new 8XX number 

Customer will submit new 
request when issue is 
resolved 

If customer entered 8XX in 
error, no action is needed 

No Yes Yes Yes 
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Dedicated 8XX Batch File Error Handling, Continued 

  
Batch File Submit Validation Errors (continued) 
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5  Customer
/ 

SDR 

“8XX is reserved for 
another CenturyLink 
user." 

8XX number has an 
active reservation for 
another CenturyLink 
user 

Service Delivery 
Representative will 
investigate the status of the 
reservation and determine if 
the 8XX can be reserved 
and provided the customer 

If the 8XX reservation has 
been lost to another carrier 
the customer will need to 
reserve a new 8XX number 

Customer will submit new 
request when issue is 
resolved 

If customer entered 8XX in 
error, no action is needed 

No Yes Yes Yes 

6  Customer
/ 

SDR 

“Carrier does not 
provide service in 
this region.” 

CenturyLink is unable 
to offer service for the 
8XX number in the 
region provided 

If TFN is authorized for long 
distance with CenturyLink, 
the SDR will need to order 
the TFN via a traditional 
order 

If customer entered 8XX in 
error, no action is needed 

No Yes Yes Yes 

7  Customer
/ 

SDR 

“8XX contains an 
invalid RespOrg Id 
for Complementary 
service. Please 
correct and 
resubmit.” 

8XX number contains 
a RespOrg ID value 
that does not equal a 
complementary 
carrier; however a 
complementary order 
type was selected 

Service Delivery 
Representative will 
investigate the status 
RespOrg Id, if the RespOrg 
ID is not available in the TF 
table (RespOrg Definition)  
the SDR will work with 
network provisioning to 
have the ID added 

If the RespOrg ID is 
available in the TF table 
(RespOrg Definition) the 
Service Delivery 
Representative will enter a 
System Issue ticket via the 
WPS Issues database for 
resolution 

Customer will submit new 
request when issue is 
resolved 

If customer entered 8XX in 
error, no action is needed 

No Yes Yes Yes 
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Dedicated 8XX Batch File Error Handling, Continued 

  
Batch File Submit Validation Errors (continued) 
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Action 
Required 
By 

Error Message 
Reason for Error 
Message 
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8  Customer
/ 

SDR 

“The Product 
Account ID defined 
on record does not 
support DTFO. 
Please correct and 
resubmit.” 

8XX number contains 
a product account ID 
value that does not 
support a dedicated 
termination 

Customer may modify TFNs 
that exist on a product 
account id that supports 
dedication toll free services  

Service Delivery 
Representative will assist 
the customer in creating a 
product account id that will 
support dedicated toll free 
services 

If customer entered 8XX in 
error, no action is needed 

No Yes Yes Yes 

9  Customer “8XX has enhanced 
features defined; 
enhanced indicator 
must equal "Y." 
Please correct and 
resubmit.” 

8XX number contains 
enhanced features; 
however the 
enhanced indicator 
does not equal “Y” 
(Yes) 

Customer must enter a valid 
enhanced indicator value 
that equals “Y” (Yes) when 
percent allocation is 
requested and “N” (No) 
when percent allocation is 
not requested 

No Yes Yes Yes 

10  Customer “8XX has an 
enhanced indicator 
equal to "Y", 
enhanced features 
must be defined. 
Please correct and 
resubmit.” 

8XX number contains 
an enhanced 
indicator value equal 
to “Y” (Yes); however 
there are no 
enhanced features 
defined 

Customer must enter a valid 
enhanced indicator value 
that equals “Y” (Yes) when 
percent allocation is 
requested and “N” (No) 
when percent allocation is 
not requested 

No Yes Yes Yes 

11  Customer
/ 

SDR 

“Customer Account 
ID defined on record 
does not match one 
under the Customer 
ID provided. Please 
correct and 
resubmit.” 

8XX number contains 
a customer account 
ID value that does not 
match one found 
under the customer 
ID 

Service Delivery 
Representative will 
investigate the status 
customer account id 
location 

If the customer account id is 
not found under the order 
customer code the SDR will 
assist the customer in 
supporting any changes via 
a traditional order 

Customer will submit new 
request when issue is 
resolved 

If customer entered 8XX in 
error, no action is needed 

No Yes Yes Yes 
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Dedicated 8XX Batch File Error Handling, Continued 

  
Batch File Submit Validation Errors (continued) 
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Action 
Required 
By 

Error Message 
Reason for Error 
Message 
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12  Customer
/ 

SDR 

“8XX is pending on 
another order for a 
CenturyLink user.” 

8XX number has 
another order 
pending for a 
CenturyLink user 

 Service Delivery 
Representative will 
investigate the pending 
order and determine if 
the order should be 
closed, cancelled, or 
escalated for completion 

 Customer will submit 
new request when issue 
is resolved 

 If customer entered 8XX 
in error, no action is 
needed 

No Yes Yes Yes 

13  Customer
/ 

SDR 

“8XX is active on 
another account not 
found under your 
Customer ID. Please 
contact your AM for 
assistance.” 

8XX number is active 
on another customer 
account ID that is not 
found under your 
customer ID 

 Service Delivery 
Representative will 
investigate the status of 
the TFN 

 If the TFN can be 
transferred, the SDR will 
need to enter a change 
via a traditional order 

 If customer entered 
request in error, no 
action is needed 

No Yes Yes Yes 

14  Customer
/ 

SDR 

“The selected 8XX 
can not be 
transferred” or “8xx 
is not transferable. 
Please contact your 
AM for assistance.” 

8XX number cannot 
be transferred 

 Service Delivery 
Representative will 
investigate the 8XX and 
confirm the  status of the 
TFN 

 If a the TFN can be 
transferred, the SDR will 
need to enter a change 
via a traditional order 

No Yes Yes Yes 

15  Customer “8XX has DNIS, 
DTO or Real Time 
ANI defined on 
record and a SWI 
termination method. 
Please correct and 
resubmit.” 

8XX number contains 
features, however the 
termination method 
entered on the file 
indicates switch 
services 

Customer must enter a valid 
a termination method value 
that equals “DED” or “OCC” 

No Yes Yes Yes 
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Dedicated 8XX Batch File Error Handling, Continued 

  
Batch File Submit Validation Errors (continued) 
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Requir
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Reason for Error 
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16  Custom
er/ 

SDR 

“8XX is in a "XXXX" 
status with "XXXX." 
Please correct and 
resubmit.” 

 8XX number has 
an reserved, 
working, or 
disconnected 
status profile in the 
national database 
with another 
carrier 

 If the CenturyLink 
is RespOrg = "Y" 
and RespOrg ID = 
"LGT01", then 
check the NSMS 
to validate that the 
8XX has LGT01 
as the current 
RespOrg, if not 
LGT01 reject the 
record and report 
the actual status in 
the reject record 

 If the CenturyLink 
is RespOrg = "N" 
and RespOrg ID is 
not equal to 
"LGT01", then 
validate the 
RespOrg provided 
in file is that same 
as the RespOrg in 
the NSMS, if not 
reject the record 
and report the 
actual status of the 
reject record 

 Service Delivery 
Representative will 
investigate the status of 
the TFN and determine if 
the 8XX can be reserved 
or transferred to the 
customer 

 If the 8XX can not be 
reserved of transferred 
the customer will need to 
select a new 8XX 
number 

 Customer will submit 
new request when issue 
is resolved 

 If customer entered 8XX 
in error, no action is 
needed 

No No Yes Yes 
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Dedicated 8XX Batch File Error Handling, Continued 

  
Batch File Submit Validation Errors (continued) 
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Action 
Required 
By 
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Reason for Error 
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17  Customer
/ 

SDR 

“8XX is in a SPARE 
status. Please 
reserve the number 
and resubmit.” 

 8XX number is 
found in a spare 
status in the 
national database 

 If the CenturyLink 
is RespOrg = "Y" 
and RespOrg ID = 
"LGT01", then 
check the NSMS 
to validate that the 
TFN status in the 
NSMS is not 
"Spare", if status is 
"Spare" in the 
NSMS reject the 
record and report 
the actual status in 
the reject record 

 If the CenturyLink 
is RespOrg = "N" 
and RespOrg ID is 
not equal to 
"LGT01", then 
validate that the 
TFN status in the 
NSMS is not 
"Spare", if status is 
"Spare" in the 
NSMS reject the 
record and report 
the actual status in 
the reject record 

 SDR will investigate the 
status of the reservation 
and determine if the 8XX 
can be reserved and 
provided to the customer 

 If the 8XX reservation 
has been lost to another 
carrier the customer will 
need to reserve a new 
8XX number 

 Customer submits new 
request when issue is 
resolved 

 If customer entered 8XX 
in error, no action is 
needed 

No No Yes Yes 
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Dedicated 8XX Batch File Error Handling, Continued 

  
Batch File Submit Validation Errors (continued) 
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Action 
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Reason for Error 
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18  Customer
/ 

SDR 

“8XX is in a 
DISCONNECT 
status. Please 
correct and 
resubmit.” 

 If the CenturyLink 
is RespOrg = "N" 
and RespOrg ID is 
not equal to 
"LGT01", then 
validate that the 
TFN status in the 
NSMS is not 
"Disconnect", if 
status is 
"Disconnect" in the 
NSMS reject the 
record and report 
the actual status in 
the reject record 

 If the CenturyLink 
is RespOrg = "N" 
and RespOrg ID is 
not equal to 
"LGT01", then 
validate that the 
TFN status in the 
NSMS is not 
"Disconnect", if 
status is 
"Disconnect" in the 
NSMS reject the 
record and report 
the actual status in 
the reject record 

 SDR will investigate the 
status of the TFN and 
determine if the 8XX can 
be reconnected and 
provided to the customer 

 Customer submits new 
request when issue is 
resolved 

 If customer entered 8XX 
in error, no action is 
needed 

No No Yes Yes 

19  Customer “The selected call 
plan contains a SWI 
termination default 
address and may 
not be modified via 
this application. 
Please contact your 
Account Manager 
for assistance” 

 8XX may not be 
processed with a 
Switched 
Termination 
Method via this 
functionality 

 Customer submits new 
request with DED or 
OCC termination method 

 If customer entered 8XX 
in error, no action is 
needed 

No Yes Yes Yes 

20  Customer
/ 

SDR 

“The given 8XX 
does not have an 
active profile. Please 
contact your 
Account Manager 
for assistance.” 

 8XX must have a 
profile to complete 
a transfer request 

 SDR will investigate the 
status of the TFN and 
determine if the 8XX can 
be transferred 

 Customer or SDR will 
need to submit a new 
request when issue is 
resolved 

 If customer entered 8XX 
in error, no action is 
needed 

No Yes Yes Yes 
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Dedicated 8XX Batch File Error Handling, Continued 

  
Batch File Submit Validation Errors (continued) 
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21  Customer “The 8XX may not 
be transferred to a 
Switched 
Termination 
Method.” 

8XX can not be 
transferred to a SWI 
termination method 
via this functionality 

Customer will need to 
request a manual order 

If customer entered 8XX in 
error, no action is needed 

No Yes Yes Yes 

22  Customer
/ 

SDR 

“A System Error has 
occurred while 
processing your 
Order. Please 
contact your 
Account Manager.” 

An unexpected 
system error has 
occurred 

Service Delivery 
Representative will 
investigate the status of the 
application 

Customer submits new 
request when issue is 
resolved 

No Yes Yes Yes 

23  Customer
/ 

SDR 

“The selected 8XX 
can not be modified 
via this application. 
Please contact your 
Account Manager 
for assistance.” 

Features requested 
cannot be modified 
via this functionality – 
Intl COS 

Customer will need to 
request a manual order 

If customer entered 8XX in 
error, no action is needed 

No Yes Yes Yes 

24  Customer
/ 

SDR 

“Trunk Group 
defined on record is 
not In Service/ 
Active. Please 
correct and 
resubmit.” 

8XX number contains 
a trunk group value 
that is not found "In 
Service" 

Customer must enter a valid 
trunk group value that is not 
pending turn-up or is 
disconnected 

If the trunk group should be 
active, contact your account 
manger for assistance 

The Service Delivery 
Representative will 
investigate the status of the 
trunk group and provide 
assistance to resolve 

Customer will submit new 
request  when issue is 
resolved 

No Yes Yes Yes 
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Dedicated 8XX Batch File Error Handling, Continued 

  
Batch File Submit Validation Errors (continued) 
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25  Customer
/ 

SDR 

“8XX has a 
disconnected 
Customer Account 
ID defined on 
record. Please 
correct and 
resubmit.” 

8XX number contains 
a customer account 
ID value that is 
disconnected 

Customer must enter a 
active customer account id 
to add 8XX services 

If customer account id 
should be active, contact 
your account manger for 
assistance 

The Service Delivery 
Representative will 
investigate the status of the 
customer account id.  If the 
account needs reconnected 
the account manger will 
perform the change via a 
traditional order 

Customer will submit new 
request when issue is 
resolved 

No Yes Yes Yes 

26  Customer
/ 

SDR 

“Product Account ID 
defined on record 
does not match one 
under the Customer 
Account ID 
provided. Please 
correct and 
resubmit.” 

8XX number contains 
a product account ID 
value that is not 
found under the 
provided customer 
account ID 

Customer must enter a valid 
product account ID value 
that is found under the 
provided customer account 
ID 

If product account id value 
should be found under the 
customer account, contact 
your account manger for 
assistance 

The Service Delivery 
Representative will 
investigate the status of the 
product account id.  If the 
account needs reconnected 
the account manger will 
perform the change via a 
traditional order 

Customer will submit new 
request  when issue is 
resolved 

No Yes Yes Yes 
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Dedicated 8XX Batch File Error Handling, Continued 

  
Batch File Submit Validation Errors (continued) 
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27  Customer
/ 

SDR 

“8XX has a 
disconnected 
Product Account ID 
defined on record. 
Please correct and 
resubmit.” 

8XX number contains 
a product account ID 
value that is 
disconnected 

Customer must enter a 
active product account id to 
add 8XX services 

If product account id should 
be active, contact your 
account manger for 
assistance 

The Service Delivery 
Representative will 
investigate the status of the 
product account id.  If the 
product account id needs 
reconnected the account 
manger will perform the 
change via a traditional 
order 

Customer will submit new 
request when issue is 
resolved 

No Yes Yes Yes 

28  Customer
/ 

SDR 

“8XX has a DTO 
Trunk Group defined 
on record that is not 
In Service/ Active. 
Please correct and 
resubmit.” 

8XX number contains 
a DTO trunk group 
value that is not 
found "In Service” 

Customer must enter a valid 
DTO trunk group value that 
is not pending turn-up or is 
disconnected 

If the trunk group should be 
active, contact your account 
manger for assistance 

The Service Delivery 
Representative will 
investigate the status of the 
trunk group and provide 
assistance to resolve 

Customer will submit new 
request when issue is 
resolved 

No Yes Yes Yes 
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Dedicated 8XX Batch File Error Handling, Continued 

 
Batch File Submit Validation Errors (continued) 
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29  Customer “The given 8XX is 
reserved for 
another 
Responsible 
Organization ID.” 

Customer must have 
the active reservation 
for the 8XX number 

Service Delivery 
Representative will 
investigate the status of the 
reservation and determine if 
the 8XX can be ordered 

If the customer does not 
have the active reservation 
the customer will need to 
reserve a new 8XX number 

Customer will submit new 
request when issue is 
resolved 

If customer entered 8XX in 
error, no action is needed 

No Yes Yes Yes 

30  Customer/ 

SDR 

“The given 8XX 
has an invalid 
Class of Service 
and CenturyLink 
to be RespOrg on 
record. Please 
correct and 
resubmit.” 

8XX Class of Service 
value must not equal 
‘9XX’ when 
CenturyLink to be 
RespOrg = Yes 

If CenturyLink to Be 
RespOrg = No, then 
COS ‘9XX’ can be 
used 

Customer must submit new 
request  correct CenturyLink 
to be RespOrg indicator 

If customer entered 8XX in 
error, no action is needed 

No Yes Yes Yes 

 Customer “CenturyLink is 
currently not 
authorized for 
long-distance 
business in this 
state. Please 
contact your 
Account Manger 
for assistance” 

  CenturyLink is not 
authorized to sell 
services for this state 

  Customer must enter a 
valid request 

 If customer entered 8XX in 
error, no action is needed 

No Yes Yes Yes 

 Customer/ 

Service 
Delivery 
Representa
tive 

 

“8XX contains an 
invalid RespOrg Id 
for the ordering 
Customer ID.  
Please correct 
and resubmit.” 

  Customer must 
have their 
Complementary 
RespOrg ID defined 
in the Customer 
Association table 

 

  Service Delivery 
Representative will 
investigate the status 
RespOrg Id, if the RespOrg 
ID is not available in the 
Control Center customer 
association table the SDR 
will enter a System Issue 
ticket via the WPS Issues 
database for resolution 

  Customer will submit new 
request when issue is 
resolved 

  If customer entered 8XX 
in error, no action is needed 

No Yes Yes Yes 
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Dedicated 8XX Batch File Error Handling, Continued 

 
Batch File Submit Validation Errors (continued) 
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31  Customer/ 

Service 
Delivery 
Representa
tive 

“8XX contains an 
invalid Internal 
Indicator for 
Complementary 
service.  Please 
correct and 
resubmit.” 

  Internal Indicator 
must equal “N” for 
Complementary 
Service 

  Service Delivery 
Representative will 
investigate the status of the 
RespOrg ID, if the RespOrg 
ID is not set-up correctly in 
the TF table (RespOrg 
Definition)  the SDR will 
work with network 
provisioning to have the 
indicator and/or RespOrg ID 
issue resolved 

  Customer will submit new 
request when issue is 
resolved 

  If customer entered 8XX 
in error, no action is needed 

No Yes Yes Yes 

32  Customer/ 

Service 
Delivery 
Representa
tive 

“8XX contains an 
invalid Active 
Indicator for Toll 
Free service.  
Please correct 
and resubmit.” 

  Valid Indicator 
must equal “Y” for 
Complementary 
Service 

  Service Delivery 
Representative will 
investigate the status of the 
RespOrg ID, if the RespOrg 
ID is not set-up correctly in 
the TF table (RespOrg 
Definition)  the SDR will 
work with network 
provisioning to have the 
indicator and/or RespOrg ID 
issue resolved 

  Customer will submit new 
request when issue is 
resolved 

  If customer entered 8XX 
in error, no action is needed 

No Yes Yes Yes 

33  Customer/ 

Service 
Delivery 
Representa
tive 

“8XX contains an 
invalid RespOrg Id 
for CenturyLink 
service.  Please 
correct and 
resubmit.” 

 

  8XX number 
contains a RespOrg 
ID value that does not 
equal “LGT01”; 
however a new 
(CenturyLink) order 
type was selected 

Customer must enter a 
RespOrg ID of “LGT01” 
when the order type equals 
“N” 

If customer entered 8XX in 
error, no action is needed 

 

No Yes Yes Yes 
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Dedicated 8XX Batch File Error Handling, Continued 

  
Batch File 
Submit 
Network 
Errors 

The table below describes batch file submit network errors you may 
see. 

 

Item 
Action 
Required 
By 

Error Message 
Reason for 
Error Message 

Action Required 
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1 Customer/ 

SDR 

“Additional CenturyLink 
action is needed to 
provision this 8XX number. 
Please forward all order 
details related to this 8XX 
to your Account Manager 
to start the internal order 
process.” 

An error has 
occurred during 
the network (on-
net, off-net, or 
NSMS) 
provisioning 
process 

The Service Delivery 
Representative will 
investigate and determine 
the status of the TFN 

Customer will submit new 
request when issue is 
resolved 

No No Yes Yes 

   
General 
Control 
Center Errors 

The table below describes general Control Center errors you may see. 

 

Item 
Action 
Required 
By 

Error Message 
Reason for Error 
Message 

Action Required 

1  Customer/ 

SDR 

“We are experiencing 
technical difficulties. Please 
verify your information and try 
again.” 

A system problem has 
prevented the request 
from being executed 

Customer or Service Delivery Representative 
should wait approximately 5 minutes and 
submit the request again 

2  Customer/ 

SDR 

“Sorry. This page is currently 
unavailable.” 

A system problem has 
prevented the request 
from being executed 

Customer or Service Delivery Representative 
should wait approximately 5 minutes and 
submit the request again 

3  Customer/
SDR 

“Sorry, but your roles do not 
allow access to this 
functionality. Please contact 
your Account Manager for 
more information.” 

The user has 
insufficient privileges to 
complete the requested 
action 

Customer should contact their Service Delivery 
Representative for more information regarding 
this error message 

4  Customer/ 

SDR 

“Failed to locate Control 
Center Customer ID.” 

A system problem has 
prevented the request 
from being executed 

Customer or Service Delivery Representative 
should retrieve the 8XX and submit the request 
again 

5  Customer/ 

SDR 

“Cannot find bean CPC is 
scope session.” 

A system problem has 
prevented the request 
from being executed 

Customer or Service Delivery Representative 
should retrieve the 8XX and submit the request 
again 

6  Customer/ 

SDR 

“An error has occurred while 
processing your request. 
Your Session has timed out.” 

The system has logged 
you out of the 
application based on 
your idle time 

Customer or Service Delivery Representative 
should retrieve the 8XX and submit the request 
again 

Continued on next page 
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Dedicated 8XX Batch File Error Handling, Continued 

  

General Control Center Errors (continued) 
 

Item 
Action 
Required 
By 

Error Message 
Reason for Error 
Message 

Action Required 

7  Customer/ 

SDR 

“An error has occurred while 
processing your request for 
8xxXxxXxxx (Null). 

A system problem has 
prevented the request 
from being executed 

Contact Service Delivery Representative for 
assistance 

Service Delivery Representative will enter a 
System Issue ticket via the WPS Issues database 
for resolution 

Customer will submit new request when issue is 
resolved 

8  Customer/ 

SDR 

“System Error: Unable to 
validate service using 
p_validate_status_8XX. 
Please contact IT Support. 
Error while executing the 
GBUS API ORA-
06508:PL/SQL: could not find 
program unit being called.” 

A system problem has 
prevented the request 
from being executed 

Contact Service Delivery Representative for 
assistance 

Service Delivery Representative will enter a 
System Issue ticket via the WPS Issues database 
for resolution 

Customer will submit new request when issue is 
resolved 

9  Customer/ 

SDR 

“Database connection 
problem.java.sql.SQL. 
Exception: ORA-01008: not 
all variables bound.” 

A system problem has 
prevented the request 
from being executed 

Contact Service Delivery Representative for 
assistance 

Service Delivery Representative will enter a 
System Issue ticket via the WPS Issues database 
for resolution 

Customer will submit new request when issue is 
resolved 

10  Customer/ 

SDR 

“Java.lang.NullPointer 
Exception.” 

A system problem has 
prevented the request 
from being executed 

Contact Service Delivery Representative for 
assistance 

Service Delivery Representative will enter a 
System Issue ticket via the WPS Issues database 
for resolution 

Customer will submit new request when issue is 
resolved 

11  Customer/ 

SDR 

“Could not load customer 
trunks from Control Center.” 

The user has no lower 
level circuits or trunk 
groups in service 

Contact Service Delivery Representative for 
assistance 

Service Delivery Representative shall investigate 
the status of the trunk group/circuits and assist in 
the turn-up of any pending facilities 

Customer will submit new request when issue is 
resolved 

12  Customer/ 

SDR 

“Unable to create On Hold 
Call Plan.ORA-20210: 
Unable to create On Hold 
Call Plan.^General error 
message/ORA-02049: 
timeout: distributed 
transaction waiting for lock” 

The user may have 
closed the session 
before submitting the 
changes to the 8XX 

Contact Service Delivery Representative for 
assistance 

Service Delivery Representative will enter a 
System Issue ticket via the WPS Issues database 
for resolution 

Customer will submit new request when the call 
plan is unlocked 

Continued on next page 
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Dedicated 8XX Batch File Error Handling, Continued 

  
General Control Center Errors (continued) 

 

Item 
Action 
Required 
By 

Error Message 
Reason for Error 
Message 

Action Required 

13  Customer/ 

SDR 

“Insufficient privileges” A system problem has 
prevented the request 
from being executed 

Contact Service Delivery Representative for 
assistance 

Service Delivery Representative will enter a 
System Issue ticket in the WPS Issues database 
for resolution 

Customer will submit new request when issue is 
resolved 

14  Customer/ 

SDR 

“Connection error occurred 
when retrieving customer 
account ids. Please try again 
later, or contact your Account 
Manager for assistance.” 

A system problem has 
prevented the request 
from being executed 

Contact Service Delivery Representative for 
assistance 

Service Delivery Representative will enter a 
System Issue ticket via the WPS Issues database 
for resolution 

Customer will submit new request when issue is 
resolved 

15  Customer/ 

SDR 

“Connection error occurred 
when calling web service for 
validation. Please try again 
later, or contact your Account 
Manager for assistance.” 

A system problem has 
prevented the request 
from being executed 

Contact Service Delivery Representative for 
assistance 

Service Delivery Representative will enter a 
System Issue ticket via the WPS Issues database 
for resolution 

Customer will submit new request when issue is 
resolved 

16  Customer/ 

SDR 

“Control Center_USER has 
read only privileges for this 
client. Unable to modify 8XX 
Call Plan.” 

A system problem has 
prevented the request 
from being executed 

Contact Service Delivery Representative for 
assistance 

Service Delivery Representative will enter a 
System Issue ticket via the WPS Issues database 
for resolution 

Customer will submit new request when issue is 
resolved 

17  Customer/ 

SDR 

“Error performing external 
validation: 
java.rmi.RemoteException: 
com.qwest.eqsms.db.DBExc
eption: Unable to check for 
call plan changes.” 

A system problem has 
prevented the request 
from being executed 

Contact Service Delivery Representative for 
assistance 

Service Delivery Representative will enter a 
System Issue ticket via the WPS Issues database 
for resolution 

Customer will submit new request when issue is 
resolved 

18  Customer/ 

SDR 

“java.lang.IllegalArgumentExc
eption: Null property value for 
'globalDefault” 

A system problem has 
prevented the request 
from being executed 

Contact Service Delivery Representative for 
assistance 

Service Delivery Representative will enter a 
System Issue ticket via the WPS Issues database 
for resolution 

Customer will submit new request when issue is 
resolved 

19  Customer/ 

SDR 

"Unknown Host" A system problem has 
prevented the request 
from being executed 

Contact Service Delivery Representative for 
assistance 

Service Delivery Representative will enter a 
System Issue ticket via the WPS Issues database 
for resolution 

Customer will submit new request when issue is 
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Item 
Action 
Required 
By 

Error Message 
Reason for Error 
Message 

Action Required 

resolved 

20  Customer/ 

SDR 

“An unexpected error has 
occurred. Please contact your 
Account Manager for 
assistance.” 

An unexpected error 
has occurred 

Contact the Service Delivery Representative 

Continued on next page 
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Dedicated 8XX Batch File Error Handling, Continued 

  
General Control Center Errors (continued) 

 
Item Action 

Required 
By 

Error Message Reason for Error 
Message 

Action Required 

21  Customer/ 
SDR 

"error.etfi.alt.act.no_cp” A system problem has 
prevented the request 
from being executed 

 Contact Service Delivery Representative for 
assistance 

 Service Delivery Representative will enter a 
System Issue ticket via the WPS Issues 
database for resolution 

 Customer will submit new request when issue 
is resolved 

22  Customer 

Service 
Delivery 
Represent
ative 

“We are experiencing technical 
difficulties.  Please try again 
later.  Please verify your 
information and try again.” 

A system problem has 
prevented the request 
from being executed. 

The customer or Service Delivery 
Representative should wait approximately 5 
minutes and submit the request again. 

23  Customer 

Service 
Delivery 
Represent
ative 

“Sorry, but your roles do not 
allow access to this 
functionality.  Please contact 
your Account Manager for 
more information”. 

The user had insufficient 
privileges to complete 
the requested action. 

Customers should contact their Service Delivery 
Representative for more information regarding this 
error message. 

 


